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In this section you will find all the flow charts that provide a
high level overview of the process for GerbTool.

General Process Flow

Import Wizard

|

Tag Layers
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Border Layer?

Review layers and
data to determine
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may need to create

No—Jp»] Create Border

s your Drill laye
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No—p»{ drill layer to NC
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Setup/Sort
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No—p»{ Run Align Layers

Export files
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Masks

Generate/Optimize

Y
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Netlist Compare
ave errors?,
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Import External
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Edit Origin
(epsiiz) SHapiEacs 1. Review any errors in the
Error Analysis Manager
2. Use Select Draws to
convert pads that were
missed due to errors.
Delete Garbage Dlr\al\‘a:?;:‘ :Ital ';h
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GerbTool Basics

In this lesson we will describe the location and use of the primary
toolbars and windows as well as general navigation for the GerbTool
(GT) application window.

Purpose

The purpose of this lesson is to familiarize the user with application
window (UI) of GerbTool including the location and use of the various
windows and toolbars.

» Definitions
0 GT: GerbTool
o UI User Interface
0 GTD: GerbTool Database file or job
(o]

Composite: A composite is a single layer (and
hence, a single Gerber file), which is made up of a
set of positive (dark) and negative (clear) layers.
They are used to route traces on power planes.
Lesson objectives
In this lesson you will do the following:
» Start up GerbTool using 3 methods.
» Learn to navigate the workspace.
» Identify the location and use of your toolbars.
» Identify the location and use of the Navigator window.
» Identify the location and use of the Colors window.
» Identify the location and use of the Selection Filter window.
» Identify the location and use of the Properties window.
» Identify the location and use of the online Help.

» Learn to navigate inside the workspace area.

Estimated completion time

This lesson usually takes 30 minutes to complete.

GerbTool Training Guide 2
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Navigating GerbTool

The first thing you want to know about any software tool is how to
navigate your way around. The graphic in Figure 1.1 below gives you a
topographical view of the application window. We will also cover the
how to navigate your way around the workspace area and the various
windows.

Note: Please copy the “TrainingFiles” directory from the course data
you were given with this manual and paste it onto your computer’s
desktop. Then open this directory and double-click the file “IPC-
Demo.gtd”

GerbTool Ul Layout

The main GerbTool window, or "desktop", is illustrated below. All
toolbars and control bars may be moved to a location you prefer by
clicking on the bar and dragging it to a new location. They may be
docked to an edge of the GerbTool window, or float in a small window.
Most of the items in the window can also be resized or closed so that
you can customize the space to suit your needs.

Figure 1.1
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Navigating the Workspace

Here we will discuss how to maneuver in the workspace area of the
application window and what the Left Mouse Button (LMB) and Right
Mouse Button (RMB) behaviors are.

LMB Behavior.

The default behavior for the LMB, when no other command 1s
being executed, is to draw a view-window. The first click starts
the view-window, and then you drag your mouse to the size of
the area you wish to zoom into. The second click executes the
zoom command for the area you specified.

When executing commands from the menus or toolbars your
LMB behavior will often be modified for the duration of the
command. The exact behavior is determined by the command
you selected and will be specified in the Hints\Prompts area in
the lower-left corner of the application. For most commands,
your LMB is used to select the object(s) to be effected by the
command.

RMB Behavior.

There are two default behaviors for the RMB depending on
where your mouse pointer is when you click it.

Cancel Esc 1. If your mouse pointer is hovering over a
N zz:z Shmﬂ blank area in the workspace when you right-
Undo Al ww  click, a pop-up menu (see left image) will
"bf C°°;ds--- | ¢ appear listing several frequently used
Rel Coords... Ctrl+C . .
P i = commands such as zooming options and
) . +[] Add to Select Group
& View Al aww  layer surfing. "
Mext Deode D % Lopy
Prev Deode Ctr+D 2. If your mouse pointer is hovering *® "<
Next Layer L b. t . th k th t > Delete
prey Layer wia  OVer anobject in the workspace, tha - |
& pan »  object is selected and a much smaller FH EditDeode...
?i o """ pop-up menu (see right image) with D330 Active
AllLayers On »  frequently used edit commands appears. Bring To Front
All Layers OFf Cirl+A . . Dark
1 Grid Snap s a. If more than one object is Clear
HH Grid View G k .
located near your mouse pointer Choose Selection X
_ rwalbends @ when you right-click, such as Propertes Tee LmA
m Composites View v . . . Flash 2
Highlights +  objects from other layers directly D35: 0. 1960:0.0860  Flash 2
. L ;0. lash
*‘“"‘” Pan e+  under your mouse pointer, then e e ;
Mill View T
. . . . : 0, W
tercecrid..  cose  you will first be presented with a . s
lverses.. stk gelection dialog asking you to select | |€ >
Screen Print Cirl+
Run Macra M oK | Cancel
Edit System Flags... Ctrl+F
Me Units... Cirl+M
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the specific object to be edited or queried.

Hot Keys & Function Keys

There are many Hot Keys available to GerbTool users that can make
the overall processing of gerber data that much more efficient. You
will find the Hot Keys listed next to each command they execute in the
various menus. A complete list of all available Hot Keys is available in
the online Help.

GerbTool comes pre-configured with the following function key
assignments:

Key Assignment

F1 Help

F2  View|Film Box

F3  View|Previous

F4  ViewlAll

F5 Setup|Layers

F6  Setup|Apertures

F7  Documentation|Reports|Apertures
F8 Query|Highlight

F9  Query|ltem

F10 Menu

F11 Edit|Select|Add To

F12 Edit|Select|Remove From

Note: Both your function keys and your mouse buttons behavior can
be modified by going to the Options | Configure command and
selecting Function Key/Mouse tab at the top of the dialog.

GerbTool Training Guide 5
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Toolbar Button Reference

Each button within the toolbar represents a shortcut to a menu
command. When you click on a toolbar button, the command
associated with that button is invoked. You can control which toolbars
appear in the window with the View | Toolbars command. You can
change which button appears in each toolbar by using the

Options | Customize Toolbar command.

Drawing Buttons are used for working with drawing layers.

Drawing Buttons

+F F R el ¥ S CEE e Y

Drill Buttons are used for working with NC data.

Drill Buttons

+
&+
+
L

i,
}H@}f

L I A A =

Edit Buttons are used for working with graphics.

Edit Buttons
P =3 v XK +@ ] #0040 +D 4+ #1 #s x4 F

AAZO 2L .~ LG veeo we 8 © | 0+0-0°0 0

Mainframe Buttons are used for working with files and setting up
layer and aperture information.

Mainframe Buttons

DEE &% ¢cf@&

Parts Buttons execute the utilities used in the reverse engineering
process.

Parts Buttons

N RS 28 B 5 1A
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Query Buttons give you quantitative information about specific
database items.

Query Buttons

EhA e up 2 @ ED ALY @

Redline Buttons are used for adding comments and other
information which are stored separately from the layer design
information.

Redline Buttons

S AFe 2 X X

Settings Buttons allow you to control the current state of many
display properties and other commonly used program settings.

Settings Buttons

DF A, e S T BB
:jj jjj \?F . " = =+ ,-*-», = E :}. E "G E
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The Navigator

The Navigator provides a quick- e Figure 1.2
reference list of your database avigator . x
elements, and another way of = Layers

-
accessing GerbTool command +- 1w Apertures
functions. Most of the Navigator +- (& Custom Apertures
functions, such as changing layer +- § NC Tools

+

names, adding apertures, and 7 Nets (1444)
printing analysis reports, are EZ Extemal Nets (0)
controlled with a right-click + Composites
shortcut menu. ? Layer Sets

—- ma Assembly
The Data Tab ] Pans

&% Fiducials
{3 Embedded Passives

@ Anahysis

The Data tab provides information
about your layers, apertures, NC
tools, nets, composites, layer sets
and Analysis runs. Functions used
for the reverse engineering of parts
for assembly, and embedded

passive data, are also available. = :
The information is displayed in a ®® Data | & Commands
tree format, displaying database

elements in an expandable/collapsible hierarchy. To expand an area of
the tree, click on the plus box (+ icon) next to the desired database
element. The "branches" of the information hierarchy are shown, and
the plus box becomes a minus box (- icon). To compress or hide the
information, click on the minus box. The information hierarchy for
that database element is hidden. If there is no Plus symbol next to a
topic in the tree, that type of element does not exist in your design, or
has been defined but is not used.

You can edit and delete database elements by right-clicking on the
various headings and the branches that are associated with each. This
not only provides you with shortcuts to functions available in the main
menu, but also some functions unique to the Navigator.

A detailed description for each database element type and how they
can be manipulated with the Navigator can be found in the online
help. We will be discussing the use of several of these functions in
more detail in later chapters.

GerbTool Training Guide 8
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Selection Filter Figure 1.3
The Selection Filter allows you to Select Filter . x
define how you want to select items, = Mode
and what types of items you wish to @ ftem
choose from. For example, depending ) Window
2 Window +Xing
on the command, you may choose 5. Types
from single item, window, group, or Flash
complete layer selections, as well as Diraw
restricting your selections to Arc
particular layers and/or D-codes, etc. Paly
When you are not in a command that E?I]i
uses the Selection Filter, the text in 5ot
the Selection Filter is gray and you Black Instance
cannot select any options. You also do Driled Circle
not have the option of using the Drilled Text
View | Selection Filter command or Mill Path
the F hotkey when not in a function Mill Circle
that uses the Selection Filter. - B Layers
E 260-71041-01_REVZ_SM1
Mode [l 3s0-71041-01_REV2_SK1
i 4 G0-71041-01_REVZ_ LY
These options define how items are 5. % D-Codes
selected. The available modes depend Al
upon the function you are in. When - § Todls
you are in Item select mode, a Al
bounding box is added to the cursor. = Polanty
Anything that falls within this 4 Dark
bounding box is a potential selection. <7 Clear
You can increase the size of the box by

pressing the PgUp hotkey, or decrease the size (for increased
accuracy) by pressing the PgDn hotkey. If more than one item exists
at the point (An X:Y location in the workspace.) you select, the Choose
Selection dialog box appears.

In Window select mode, everything that falls completely within your
selection window is selected. In Window +Xing mode, everything
inside the selection window, including anything that the window
touches, is selected.

In Layer select mode, all selected types of data on all selected layers
are chosen.

Types

These options allow you to select which kinds of items will be
included. Any type of item not checked will be excluded from the
selection.

GerbTool Training Guide 9
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Layers

These options allow you to select which layers will be considered when
choosing items.

D-Codes

These options allow you to specify items that are created using only a
particular D-code.

Tools

These options allow you to specify drill or mill items that are created
using a particular NC tool.

Polarity

These options allow you to specify only items with a particular
polarity.

Item Properties Display
Figure 1.4

When you query an item in the

. . . . . Item Properties ax
database, its information is shown in
the Ttem Properties display. The type T”'m'bum :D':'herhes
. . . ¥pe S|

of information displayed depends Deode Dias
upon the item being queried. Shape Round

Size 0.2000
A detailed description for each item Location 4.3710:2.3560

. Area 0.0314159 sg.in.

type that can be queried can be Layer L4:60-71041-01 R...
found in the online help. Layer Type  Top

Seqho 11745

Polarity Dark

Net 1442
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Color Bar

The Color Bar is available at all times to change active layer, layer
colors and visibility. Layer names are also presented for your
reference, and layer types are represented by the icon next to the layer
number. Following is a list of icons and the layer type they represent.

st Top Figure 1.5
Colors . X

~ Inner

Lyr F | D | MName e
= Bottom [l 1 07211600-03.5PP
2 Plane (Negative) _I'__'I-z D7211600-03,SILKP

. [1&33 D7211600-03.5MP
= Plane (Positive) ¥+ KN EN 07211600-03.0¥01
[l Silk Top [J==s5 N KN D7211600-03.LY02
) g :

O Silk Bottom eI K3 D7211600-03.LY03

[J==7 I 07211600-03.LY04
—— ]
=¢ Mask Top [Jweg B 07211600-03.LY05
5 Mask Bottom [+ KN EKH 07211600-03.LY06
o ] = 10 IEH KM D7211600-03.LY07
i Paste Top [ w11 277 KB D7211500-03.LY08
I Paste Bottom [ 12 KN 1Kl D7211600-03.LY09
= Border (] =13 I I D7211600-03.LY10

[J==14 » [N D7211600-03.L¥11
=% NC (Drill/Mill) (] 15 IEM Il D7211600-03.LY12
%  Composite [] w15 3 o7211800-03.LY13

' [ =17 I N D7211600-03.LY 14

& Drawing (&3 13 D7211600-03.5M5
2 Insulator [ 19 D7211600-03.51LKS v

1=
Etch (Subtractive)
Passive
1#t  Screen (Additive) Passive

External Netlist (can only be set by GerbTool after importing a
netlist)

< QOther

[+ NP layer contains item-level polarity, the Draw and Flash colors
contain a diamond shape, as shown for layer 4 in the above
illustration.

If you wish to change a layer name or type, use the Layer table or
Navigator.

GerbTool Training Guide 11
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Visibility
Visibility for individual layers, layer sets and composites is controlled
by clicking in the check box next to the desired layer number. A check

mark indicates visibility, in which state a layer can be edited; no check
mark indicates the layer is not visible, and cannot be edited.

To turn all layers on or off, right-click in the Color Bar, and select
either All On or All Off. When you select All Off, all layers except the
active layer are turned off.

Setting the Active layer

Double-clicking on a layer number makes the layer "active". You can
also right-click on the desired layer in the Color Bar, and select Set
Active from the shortcut menu. The active layer appears on top of the
other layers in the workspace (this does not change the actual layer
order). The active layer is also the layer where any newly created
objects are placed.

The active layer can also be set using the Layer Bar.

Color Selector

You can control the color of flashes and

draws for each of your layers. To changeone || [ | [ | [ |
of the colors, click on it. The Color Selector BEROEBN BRI
appears, and you can select your desired BER  BEREEER
color from the available selection. Tochange |IHBI BN EHENR
the color choice at a particular location in
the Color Selector, right-click on the desired color. This opens the
standard Windows color selector that allows you to define a color.

To dismiss the Color Selector without choosing a color, press the Esc
key.

If you have a specific set of layer colors you would like to use for all
your designs, you are provided with a file in the Macros folder called
demo.mac, which includes a macro called SetLayerColors. Use the
following steps to utilize this macro.

Open the demo.mac file the Macro Developer, and edit it to specify
your desired colors. Save the file and return to the main GerbTool
window.

Select the Macro | Load command and load the demo.mac file.

Select the Macro | Run command, and run the SetLayerColors
macro.

Tip: If you wish to run the SetLayerColors macro automatically
when GerbTool starts, rename it to OnStartup. To run it whenever
you select the File | Open command, rename it to OnOpen.
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Other Helpful Info

Undoing Edits

The Undo command provides a high level of freedom when making
database edits. When Undo is enabled, you may experiment with edits
without fear of data loss. Since undo is available as the U hotkey you
may undo edits immediately without even having to exit the current
command. Undo works for all edits regardless of size, and there is no
limit to the number of edits you can undo. Just remember to enable
Undo with the Options | Configure/General command before
making your edits. Then use the Edit | Undo command, the toolbar
button, or the U hotkey to undo changes as desired.

Programming Your Mouse and Function Keys

GerbTool’s easy-to-use Graphical User Interface (GUI) is further
enhanced with the versatility of programmable mouse and function
keys. Using the Options | Configure dialog box, you may program
both the mouse buttons and function keys F1-F12 with commands
that you frequently use and in a layout that you find comfortable.

Interrupting Redraws and Highlights

Any command that redraws the database or highlights a group of
items can be sped up by canceling the drawing process. By pressing
the Esc key, you can halt whatever is redrawing the display. This
does not effect the operation of the command; only the redraw is
effected. Once you are comfortable with the operation of various
functions, you will find that this ability significantly speeds things up.

Canceling a Command

Any command can be cancelled by pressing the Esc before it is
completed. If the command has multiple steps in its process, the Esc
key will back up one step at a time until it reaches the beginning of
the process and then cancel the command all together when pressed
one more time.
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Review questions

1. What is the primary purpose of the Navigator?

2. What is the primary purpose of the Selection Filter?

3. What is the primary purpose of the Color Window?

4. What is the primary purpose of the Properties Window?

5. What are the two functions of the Active Layer?
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Activity: Setup Toolbars

In this activity you will open GerbTool for the first time using three
different methods and you will modify your toolbar setup to a more
suitable configuration for reverse engineering Gerber to CAD.

This activity should take about 20 min to complete.
1. Open GerbTool.
» On your desktop, double-click the GerbTool icon.

» Click Start, select ALL Programs | WISE Software |
GerbTool 15.2 | GerbTool

» In Windows Explorer, browse the directory, “C:\Documents
and Settings\All Users\Application Data\WISE
Software Solutions\GerbTool 15.2\Samples”. Now double-
click on the file “demo.gtd”.

2. Open the IPC-Demo database.
» On the File menu, select Open
- or- Click the Open (&) Icon on the toolbars
- or- Press Ctrl + O

» In the Open dialog box browse to the “TrainingFiles”
directory on your desktop.

» Select the file “TPC-Demo.gtd” and click Open.

3. Enable and Disable Toolbars.

» On the View menu, select the Toalbar ~
: Main Bar
Toolbars... option. o hang
» Uncheck the Redline Bar E‘Lff;:r"e”a' Bar
.
» Check the Edit Bar and Tools Bar S:;:;aa’ar
. . . . View B
(The dialog should like the image to the right coron
when you are done.) O] Drawing Bar
[ Redline Bar
Toals Bar
(1 orill Bar v
Al on | lTl Cancel
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4. Position and dock Toolbars.

» Click on the Edit Bar | °
and drag it so that s
shadow outline is on
top of the Menu Bar
then release it.

(The Edit Bar is now
docked above the Menu

SER L Er T

BERPED 8E B

b Click on 1o =¥ the

dotted grab handle for the Menu
Bar and drag it on top of the Edit
Bar to position it back to the top
of the Toolbar stack.

» In the same manner,
position the Tools Bar to the
right side of the XY Bar. (The
application window should like
the image to the left when you
15 0 s i i G 5 e Do Ml 6 are done.)

| sl X el dsi D T AAROILER S LEre~§ 0 00000

fEO s Ta ExQae 8 SXAPE AT B0 BB DK 5. Resize the Navigator,

=|[@ Tt Rawdti iz »] |[FTmen | ¥ . .
1= .. ~ .. Properties, Colors and Selection
: Filter windows.

e arbar gt 7.0iiaphes Gaviemo Anchaes 081 ek O Do 791 5o boves @ o

For g, press F3 ¥ Al

» Position your mouse
pointer in between the
Navigator and Properties
windows until it changes to an
up/down arrow == cursor.

» Click and drag down so
that the Navigator consumes
about 2/3 of the vertical space
and the Properties window takes
up the remaining 1/3.

» Repeat this process for
the Colors and Selection Filter

- cher et 7.05ances arblene. Badraw O0 Lndo 0N [re 51 50 inches @

Foe e, press 1
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windows, but make the split closer to 1/2 and 1/2. (The
application window should like the image to above when you
are done.)

Activity: Use the Navigator

In this activity you will search for and modify various database objects
in the IPC-Demo job you opened in the previous activity.

This activity should take about 10 min to complete.

1. View Layers.

»

»

Click the plus box (+ icon) next to = Layers item to expand the
list of layers in the database.

Expand the first layer Na”iEl;mewe . x @
0423CPTP. - s Bl

W L1: 0423CPTP o]
By right clicking on the first item ﬁpﬁ’m

listed under this layer you see Pa ; Rename. ..
that you have the option to + [0 L2:0425CSTP | | =

rename the layer. (Do not rename it at this time.)

By right clicking on the second Navigator pareall R
item listed under this layer you - Layers " &
see that you have the option to -7 L1: 0423CPTP ~ || | @)
change the Type for that layer. 0423CPTP q
0 Select Other and see the W[z Top
icon change for the layer. + g L3 Inner
] sas | 4 Bottom
0 Re-expand the layer and E— LE\—[%_‘
change the type back to oo Lg  aneNeg
Paste Top. e 1T Plane Pos

Collapse the Layers list by clicking the minus box (- icon).

2. View Nets.

»

Expand the ¥ Nets list in the Navigator.

.Q% Note: Nets are only available after running the Generate Netlist
command.

»

»

»

Zoom in to a small area of the circuit image in the workspace.
Double-Click on the first Net in the list, $1N361.

Check the Zoom to Net option in the Query Net dialog that
just opened.

Click the Find button.
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NerSINB6L s now centevedin ) .

your workspace and is

3 1 uery by Mouse or
highlighted. Any other nets Query by Add User Dats... |
. . * MetMame { UserData
you double-click on will now
automatically snap to the Search For:  $1n361
center of your screen and

Pads: 5, Seqgs: 10, Length: 0.6493, Cu: 0.02 sqg.in.

highlight.

» Collapse the Nets list. = u@r rioights | I Zoom to et ggm

3. View External Nets.
Mavigator -

» Expand the layers list and double S = Loy

click on layer 14 “Li14: External 4 Yo Apertures i

Nets” to make it visible then @ Custom Apertures —

collapse the layers list again. - § NC Tooks
Note: External Nets are only available * ;_::;‘ Ezts Izlzil} -
after importing an external netlist like an T o Pema ts (227)
IPC-D-356 file. ; P%

T B mARITTY. 144

» Expand the E” External Nets list
in the Navigator.
» Double-Click on the first Net in the list, $1N361: 123.

External Net $1N361: 123 is now centered in your workspace and is
highlighted.

» Collapse the External Nets list.
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Activity: Use the Color Window

In this activity you will use the Color Window to turn layers on and
off, set the active layer and modify the layer color scheme to suit your
preferences.

This activity should take about 5 min to complete.

L

1. All On/All Off. Colors -
» Inthe Colors Window right-click on any of Lyr F |D r_“‘a”“ u
the layers listed. (] 80 1 0423
["I“ : e
» Select All On. (All layers are checked and - Set Active
become visible in the workspace.) N All On
»  Now repeat this but select All Off this time. g:l - Al U% — |
(All layers are unchecked and become e

invisible in the workspace except for the
active layer.)

2. Set the Active Layer.
» In the Colors Window right-click on the Top Silk layer.

» Select Set Active. (The layer name and number change to a
red font and the Top Paste layer changes to a black font.)

» You can also set the Active Layer by double-clicking a layer in
the Color Window.

Colors . X
3. Modify Layer Colors. Lyr F | D | Namea
. . O
» In the Colors Window, left-click on the %; F::i

color square in the F (Flash) column for
the Top Silk layer.

Sininn =
WO | o4s

. |-|Im B 0423
» Select a color of your choice, cyan for I = =||: = = .= = [ e

example. = | JErE

Note: You don’t see anything change in your workspace. This is
because all objects on the Top Silk layer are drawn rather than
flashed.

» Now repeat this process for the D (Draw) column. Now all the
objects on the Top Silk layer are changed in your workspace to
the new color you selected.

Tip: It is a good practice to use contrasting colors for your Draw and
Flash columns on your Top and Bottom copper layers. (Green and
Blue IH for example.) This will help you to see graphically whether
pads have been converted from drawn to flash or not before you try to
reverse engineer. It is a requirement for all pads to be a flash for the
reverse engineering process to work.
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Importing Gerber Layers

In this lesson we will describe the steps and processes used to import
your data files into GerbTool.
Lesson objectives
In this lesson you will do the following:
» Learn the function and use of the Import Wizard.
» Learn about the different file types that can be imported.

» Learn to evaluate your data set to determine what reverse-
engineering process you will use.

Estimated completion time

This lesson usually takes 15 minutes to complete.
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The Import Wizard

The Import Wizard allows you to specify which files (Gerber,
aperture lists, GerbTool databases, Drill files, etc.) you wish to
1mport, assign aperture lists to specific Gerber files, and order
the loading sequence. GerbTool automatically recognizes the file
types, and imports the specified files into the first empty block of
consecutive layers found. D-codes with multiple definitions are
automatically remapped to new D-codes, as needed.

To use the Import Wizard

1. Make sure all the files you wish to import are in the same
folder.

2. Select the File |Import | Import Wizard command. Page 1 of
the Import Wizard appears:

My Data Is In

Enter the name of the folder containing your files to import.
Click the Browse button to search for the folder.

Configure File Types To Ignore

This button opens the Configuration dialog box, where you may
enter any file name extensions that you want the program to
ignore when scanning the folder. The more files that may be
safely ignored, the faster the Import Wizard will be able to scan
the specified folder. .

Figure 2.1

Import Wizard

Page 1cof 4

This Wizard will help you quickly import your data files.

P
(i |
k. " 4

Select the folder that contains your data files.

My data is in

\Gerb Tool DemoPC-Demo*2740 Gerber Set - Browse...

Configure file types to ignore... |

Corfigure aperture list converters. .. |

| Meat = | Cancel Help
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Configure Aperture List Converters

This button opens the Configuration dialog box, where you may
specify which aperture list converters should be enabled. The
more aperture list converters enabled, the longer it will take to
scan the specified folder.

3. Click the Next button to continue to Page 2 of the Import
Wizard. This page presents the list of files that GerbTool found
in the selected import folder. Click on the list column headers
to sort the list based on the data within the respective columns.

Filename

Indicate whether GerbTool should import a file by putting a
check mark by the filename. Click the Unselect All Importable
button if you wish to remove the check marks next to all file
names.

File Type

All importable file types are indicated (if a file cannot be
imported, "???" appears.) If GerbTool detects the file type
incorrectly, you may change it by clicking on the file type in
question, and selecting the correct type from the shortcut menu.

Data Format

This column indicates the detected data format for each file. To
override the detected format, click on the appropriate entry.

If the file is Gerber, the Gerber Import Data Format dialog box
appears.
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If the file is an aperture list, the Select Converter dialog box
appears. GerbTool has already selected an appropriate
aperture converter to use for your aperture list, if one is
available. To override the selection, select a different converter
to use from the Data Format list. You can have your selection
applied to all incoming aperture lists by clicking the Apply To
All button. You can create a new converter by clicking the New
Converter button.

If the file 1s an NC tool list, the Select Converter dialog box
appears. GerbTool has already selected an appropriate
converter to use for your tool list, if one is available. To
override the selection, select a different converter to use from
the Data Format list. You can have your selection applied to all
incoming tool lists by clicking the Apply To All button. You can
create a new converter by clicking the New Converter button..

If the file 1s DXF, the Import DXF dialog box appears.
If the file 1s HPGL, the HPGL Import dialog box appears.
If the file is DPF, there are no format parameters to modify.

If the file is NC (drill or mill) data, the Import NC Data dialog
box appears.

Length
The size of the file, in bytes.
Date
The date that the file was last modified.
Show Unknown File Types
By default, the Wizard only displays those files it can identify.

Select this option if you wish to see all files contained in the
selected import folder.
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4. Click the Next button to continue.

If you are importing any 274-D files, Page 3 appears. This page is used
to assign 274-D Gerber files to aperture lists. Drag each Gerber file
onto the desired aperture list. (If only one aperture list is present, all
Gerber files are automatically assigned to it.) Then click the Next
button.

If you are not importing any 274-D files, Page 3 is skipped.

Page 4 presents the final list of files that are to be imported. The files
are imported to layers in the order they are listed. If you wish to
reorder the files so that your layers are in the proper order, click and
drag each file to the desired position.

If you wish to prevent warning messages from being displayed when
importing files, select Suppress Import Warning Messages. A log file
will still be created but you will not be prompted whether to view it.

When you are satisfied with your selections and ordering, click the
Finish button. Your files are imported and any pertinent information
or warning messages are displayed in the Log screen. You can save
the log by right-clicking on the Log screen, and selecting the Save Log
command from the shortcut menu.

Tip: Polygon Voids in 274-X files are supported, but are not
recognized as standalone entities. Voids are only relative to the closed
and filled polygon that contains them. If you query a polygon void
(Query | Item command), the information returned is for the polygon
itself. Polygon voids also cannot be modified, added, or deleted.
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Activity: Import 274D files for IPC-Demo board.

In this activity you will select all of the necessary files and converters
necessary to import the gerber layers for the IPC-Demo job.

This activity should take about 15 min to complete.

1. Create a new job.

»  Click the New icon LI on the toolbars, or

» On the File menu, select New

2. Import IPC-Demo data using the Import Wizard.

» On the File menu, select Import | Import Wizard

» Click the Browse button

0 Browse to the “...Desktop\TrainingFiles\IPC-
Demo\274D Gerber Set” directory.

» Click Next

» Click on the text in
the Data Format
column for the file

“0423CREP.DRL”.

» In the Select
Converter dialog,
click on the “Generic
Tool List (Mil) 1.0”
option.

o Click OK

Select Converter

Data Format:

GerbTool Tool List/Report 2.0
PowerPCB.acr 1.0
Smith-Cadence.acr 1.0
Smith arr 10

[~ apply to all

Cancel

]

New Converter... |

» Click Next

Import Wizard El

Page 2 of 4

Select files to import,

Click on file type and data format fields to change as needed. ‘

C:\Documents and

™ Show unknown file types

Unselect All Impartable

< Back | Next >

Filename File Type | Dats Format | Length | Date
0423CMTP.REP Aperture  Pads 1.1 1563 5-5-
0423CPTP.PHO Gerber RS5274D, 2.4, Abs, Inch,Leading 66576 3-7-C
0423CPTP.REP Aperture  Pads 1.1 1206 5-5-
Toolist  GenerigTool List(Inch) 1.0 587 55
0423CSET.PHO Gerber R&27 .4,Abs,Inch,Leading 110455  3-7-C
0423CSET.REP Aperture  GerbTool 473 5-5--
0423C5TP.PHO Gerber RS5274D,2.4,Abs,Inch,Leading 278732 37
0423CSikToRP REP Aperture  GerbTool 413 55—,
¢ | =

Cancel
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Note: In the Aperture/Tool Lists assignment tab, the gerber file
“0423CSTP.PHO?” is assigned to the “0423CLO01.REP” aperture list
instead of “0423CSilkTop.REP”. This is because GerbTool will try to
automatically assign gerber files to the closest reasonable match it can
find. If no match is found, then the gerber file will remain on the right
side window. In this case, it considered “0423CLO01.REP” to be the

first reasonable match.

» Click and drag the
“0423CSTP.PHO”
gerber file down the
list and drop it on
the
“0423CSilkTop.RE
P” aperture list.

» Click Next
» Click Finish

Note: Two of the aperture

Import Wizard

Assign basic Gerber files to aperture lists, Page 3of 4
Assign Drill Mill files to tool lists.

Assign each Gerber file to an aperture list by dragging the

.
;{') Gerber files onto the desired aperture list file.

Assign DrillMill files to Tool Lists as applicable.

®

| Aperture/Tool Lists

File Name Type

B o4z23cLo1.rer

B 0423cL01.PHO

B os23csTP.PHO
&) o423cL02.EP

B o423c02.PHO
[&1 0423cL03.REP

B 0423cL03.PHO
[&1 0423cL04RER

B 0423cL04.PHO
[&1 0423cL05.REP

B 0423cL05.PHO
[&1 0423cL08.REP

[ navzenns oun

S Back I Next > I Cancel |

lists did not have the correct converter selected by GT during the
automatic process. When this happens, you will get the Warning
message below and the will be given a chance to have GT try to find

the right converter.

» Click OK on Warning message.

» Click YES to confirm conversion message.

» Click YES to confirm
the newly selected
converter.

» Repeat this process
for the second
aperture list converter.

3. Save your GT database.

'S

"0423CSBT.REP” appears to be a "Pads 1,17 aperture list.,

\-'/ Is this acceptable?

Mo Cancel
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Click on the save icon [ or
On the File menu click Save.

Enter a name for your database such as “IPC-
Demo_<yournamehere>.gtd”.

After importing your suatoraeing s
gerber data in the :
previous activity you can
click on the Main tab

®# Main 3t the bottom of
your workspace. Your
graphic view should look
like the image on the e
right. '

: =l
woke vy —arel

e o VT e Dt 78 Baipw o6 L O Dvcl) S8 v @)

Review your data files with your instructor using the decision
diagram from Figure 2.2 to decide what your best option(s) is
for reverse engineering this job.

Review questions

1. True or False; The Import Wizard requires all associated files
to be imported to reside in the same windows directory?

2. True or False; The Import Wizard will automatically identify an
aperture list converter to use for importing an aperture table if one
1s available?

3. True or False; When using the Import Wizard, it is a good idea to

double check the detection of the data format?
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ID/Sort Layers

In this lesson we will describe the functions and processes used to
identify the different layer types of your design and how best to sort
and color them. We will also discuss the method used to create a
separate border layer if one was not provided with your original
gerber files and how to convert a gerber Drill layer to an NC Drill
layer. Finally we will remove all unnecessary “garbage” data from the
gerber layers of your job.

» Definitions

0 SMD — Surface Mount Device
THD — Thru Hole Device
Tag — Identify a layer’s type
PCB — Printed Circuit Board

Garbage data — any unnecessary drawn objects on the
gerber layers, especially the electrical layers

O O O O

Lesson objectives
In this lesson you will do the following:
» Tag layers of your design
» Create a Border layer
» Create an NC Drill layer from a gerber drill layer
» Sort layers into a sensible order
» Modify layer coloring to provide contrast

» Delete all “Garbage” data

Estimated completion time

This lesson usually takes 20 minutes to complete.
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Identifying Layer Types

Prior to any intelligent processing of the deisign, it is necessary to
identify or Tag the different layer types that were imported in during
the Import Wizard step. By default, all layers are identified with the
type, “Other”, except for an NC Drill which is automatically identified
due to its unique structure. The minimum layer types required to
complete Analysis are:

» For Netlist/Netlist Compare

0 Top and/or Bottom Copper
0 All Inner Signal layers
o0 All Plane layers

0 All NC Drill layers

» For complete DRC/MRC

All the above plus:

0 Border

0 Top and/or Bottom Mask (Paste and Solder)
0 Top and/or Bottom Silk

To change a layer’s type

1. In the Navigator, click on the plus box next to the desired

layer.

2. In the layer detail list, the second item Navigator - %
is the layer type. Right-click on the type |- T r'ff[: ocon. | —
and a shortcut menu appears. The 4o L2 0423CDRL
current layer type has a checkmark - & L3 0423CLM
next to it. #'EEE W

3. Select the new layer type from the - Svy (RN
menu. +] - & !_rE‘E Inner k

If you change the type to an NC layer, a tool table is automatically
assigned to it. Its name appears in the layer information in the
Navigator. If you want to change the assignment, right-click on the
tool table name, select the Change NC Tool Tables command, and the
name of the desired tool table.
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Activity: ID (Tag) layers from IPC-Demo job

In this activity you will use the Navigator to tag all the layers for the
IPC-Demo job.

This activity should take about 10 min to complete.

Tip: In the IPC-Demo job, as will be true for most designs you work
with, there is text on each layer identifying what the layer is (see
image below). Locating and using these text comments is the easiest
method available for identifying layers in GT. You may also find that
the file names for the gerber layers have a naming convention applied
that will help you identify the type. For example, “0423CSBT” is a
Silk-Bottom layer and “0423CSTP” is a Silk-Top layer

COMPGNENT SIDE
THIS TEXT IS READING FROM THE COMPONENT SIDE VIEW

| 20, h124
kl'l.q‘rqﬂ
I

1. Right-click on any layer in the Color Window and select All
Off.

» Note that the active layer remains checked and visible.
Uncheck the active layer now.

» Skipping the layer “0423CDRL” for now, click in the check box
next to the first undefined layer in your list to make it visible.
This should be layer “0423CL01”.

2. Use the zoom commands to zoom-in around the descriptive text
label for this layer as shown in the image above.
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3. Click the + sign to expand the Layers list in the Navigator.
» Click the + sign next to layer “0423CLO01".
» Right-click where it says Other and select Top for the type.

ggﬂe Edit View Add Setup Documentation Analysis Query Options Macro Tools Assembly User Help
P et X e+l 4040 ) 4B HI [+l s T AAAO SR Lo w8 E 00000
IDEE &7 ¢ev@&@ o] 7 mallamic @enpd 8 56 DH 8 1

i[~& Los2ac DAL ~|l® o 0otz Bath = 191812 19.0044in wsre PMEY T e PR EERTOE
Navigator . x ] | — | | Colors ==
E= e 4| 5 [Lr  [F D | MName A
& L1:0423C.DRL & OS£1 I 0423
- & CDRL g Oe2 B o423
s 0 p =3 0423
_ g Hea Il 0423
Oes 0423C
-
o b a O M o423
-3 & ‘ mr | It
Bottom | 9. 1802
= ‘ B Oes Il o0+23c
0o L8 Plane Neg Py Oes IR 0423
W 190 Plane Pos . e 10 B 0423
# & LIk sikTop o O 0423C
@ LT o un O 12l 0423
s & L2 Mack Top oy [mP= T 0423
o [ p COMPONENT SIDE < >
+ Apertursg lask Bo
@ Custom/ pasteTop — THIS TEXT IS READING FROM THE COMPONENT SIDE VIEW Select Fiter “x
E m
- B NCTool
Pacte Bot
| I, o
=@ pata | ! Border " =
NC b
| ) o
m Properties Compasits l
Attribute Drawing e

Type:

Insulator

Passive Sub i
Passive Add
Other :
[
<

[Los 8 sin |

.LJ/MOD [C:\Gerber Expert 7.0 [Redraw ON_[UndoON_Drc0 [Sel0 [Inches @

4. Repeat this process for the remaining layers (Still ignoring layer
“0423CDRL”). Try to use the descriptive text labels on the layers
and/or the layer names themselves to determine the type for each.
If you have trouble determining the type or to check if your choices
are correct you can refer to the table below.

Layer Type Layer Type Layer Type
0423CLO01 | Top 0423CL05 | Inner- 0423CPTP | Paste-
Signal Top
0423CLO02 | Inner- 0423CL06 | Bottom | 0423CSBT | Silk-
Signal Bottom
0423CLO03 | Plane- 0423CMBT | Mask- 0423CSTP | Silk-
Neg Bottom Top
0423CL04 | Plane- 0423CMTP | Mask- 0423C.DRL | Drill
Neg Top
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Creating a Border Layer

When you receive gerber files for a product it is quite likely that you
will not receive a separate layer that only represents the circuit
outline or Border. For both DRC/MRC and Advanced Panelization, it
is important to have a Border layer or at least an accurate
representation of the extents of your circuit outline for your Border
layer. For Advanced Panelization applications you will need this for
accurate spacing.

The Activity for this section will be to follow the instructions below
with the IPC-Demo job using the circuit outline from the Top
Silkscreen layer as your master for creating a Border layer.

To convert Draws to Polylines

This command converts all contiguous, drawn line segments on visible
layers into single polyline (GerbTool’s representation of a contiguous
line segment) entities. Very often your circuit outline is a represented
by a set of drawn lines on a layer such as the Silkscreen. By
converting these drawn lines into a polyline, you can make the
selection process for copying this data to a new layer very easy.

ﬁﬂ 1. Turn on the layers you wish to be processed, and turn off any
layers that you do not want processed.
2. Select the Tools| Convert | Draws To Polylines command.
All visible layers are
immediately processed, and
you are informed how many

draws were converted, and \E) 10513 draws converted into 820 palylines.

the number of resulting
polylines.

To create a Border Layer

ﬁ 1. Find an existing layer that has the border of your circuit
outline defined on it. Silkscreen layers usually have a border.

2. Select the Edit| Copy command
- OI' -
From the toolbars click the Copy icon *:&

3. Click the Destination Layers tab _ Destination Layers... | at the
bottom left corner of your application window.
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» Select the next available
<empty> layer.

Copy Destination Layers E| E|

Select Layers to Copy to

4. In the Selection Filter [] == L&: 0423CLO5 -
[ e L3: 0423CL06
» Change the Mode to Window +Xing. CIE L1o: o4230MeT

[J [) Li1:0423csET
[J5& L12: 0423C.DRL

» Also make sure the Type Poly 0% 13 Extornl Nets
is checked. Oe »
Oe -

5. Click and drag a selection box around
any portion of circuit border. (If you
ran the Draws to Polylines conversion =
then this method should allow you to
select the entire border.)

Select All | Unselect Al |

The prompt at the lower-left corner of your workspace says,
“Copy Window: enter copy from point...” In order to drop it
in the correct position on the new layer you will need to use the
Absolute Coordinates command.

6. Press the Enter key and the
Absolute Coordinates dialog
appears.

Absolute Coordinates E|

¥: |0.0000  ¥y: |0.0000

o0 Enter a value of 0 for
both X and Y fields.

o Click OK

Cancel |

You now have a copy of the border attached to your cursor and the
prompt at the lower-left corner of your workspace now says, “Copy
Window: enter insertion point...”

7. Press the Enter key again and the Absolute Coordinates
dialog appears.

0 Enter a value of 0 for both X and Y fields.
o Click OK
8. Press the Esc key twice to end the function.

9. Your circuit border has now been copied to the destination
layer you chose and should be aligned with the layer you copied
it from.

» Use the Navigator to change o
the layelj type to Bprder and to Bo rder| Rename... |
rename it appropriately. - - Lo —

—-C3 L14: zunnamed: | |
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Creating an NC Drill Layer from Gerber

When you receive gerber files for a product, sometimes you will receive
a gerber file that represents the Drill layer rather than an actual NC
Drill file with a Tool List. It is required to have an NC Drill layer that
1s recognized as such in order to identify padstacks and make an
accurate netlist.

Using the Tools | Convert | Gerber to NC command will
automatically convert this layer to an NC Drill layer and create an
accompanying Tool list for you.

So now it’s time to deal with that “0423CDRL” layer we have been
ignoring so far. Follow the directions in the activity below using the
IPC-Demo job to demonstrate how to use this function.

Activity: To convert Gerber to NC Drill
This activity should take about 5 min to complete.

ﬁ 1. Turn off all layer accept for layer * B:I

0423CDRL and zoom your workspace out | sourcetaye: [z +|
to the View All mode. (This is not a ~+504230002 A
requirement, but will make it easier for 475 0423cL03

. AF 7 0423CL04
you to see the conversion take place e 3 0423CL05

Destination Layer: |_

NC Tool Table: |—

after executing the commands below.) Tip: The Edit|Capy cof 0423108
2. Select the Tools|Convert|Gerber to NC implct data conversio 828 10 0423CMET
yer. [ 11 0423cs8T
command from the menu. The Gerber & v
To NC dlalog Ok | Cancel |

3. Select the 0423CDRL layer for the
Source Layer.

4. Select the next available <Empty> layer for the Destination
Layer.

5. Leave the NC Tool Table at its default value of <New Table>.
6. Click OK to execute the command.
7. A new NC Drill layer has been created on L ‘E' NC Tods
the Destination Layer you selected. Turn + -5 D423CREP
this layer on now to view your results. - B —
8. A new NC Tool List has also been created. ;;': Effnﬂ Nt )

Click on the “+” symbol next to the NC
Tools item in the Navigator to see it.

9. Delete the new NC Drill layer as well as the original
0423CDRL layer. We will be using the original NC Drill layer
we imported for the remainder of this job.
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Sorting and Coloring Layers

The Activity for this section will be to follow the instructions below
with the IPC-Demo job using the method from the Tip to sort layers.

Activity: Sort and Color your Layers

This activity should take about 10 min to complete.

‘ﬁ] 1. Under the Layers list in the Navigator, click on the layer you

wish to move, and continue to hold down :

the mouse button. R-BE
2. Move (drag) the mouse cursor until it is &[] Lx0geem

over the layer (in the Layers list) that you = it o

wish to move the layer to. : = uma
3. Release the mouse button. All other layers : -

are reordered, as necessary, so that no
empty layers are created and no duplicate layer numbers exist.

order them as if you were looking thru the PCB from the top down. So
a typical PCB you would use the following sequence to sort your
layers: Top Paste, Top Silk, Top Mask, Top Copper, Inner/Plane
Layers, Bottom Copper, Bottom Mask, Bottom Silk and Bottom Paste.
From there you can sort your extra layers such as Drills, Drawings,
and External Nets in any order you wish.

@ Tip: A suggested method for determining how to sort your layers is to

4. To color your layers, see the activity “Use the Color Window”
in Chapter 1 of this manual.

Review questions

1. What layers are required to process an accurate netlist?

2. Why is it important to have a Border layer?

3. What is the suggested method for sorting your layers?
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Activity: Delete Garbage Data from all layers

In this activity you will be removing all “garbage” data from the layers
of the IPC-Demo job. Garbage data such as targets, layer labels, etc...,
especially on electrical layers, will cause invalid nets when you
generate a netlist.

This activity should take about 10 min to complete.

1.
2.

In the Colors window right-click on any layer, select All On.
Turn off the Paste Layer 0423CPTP

Tip: You will often have additional layers included with your gerber
data, such as paste or drawing layers, which are not a part of the
actual electrical or physical layers of the circuit. It is neither

necessary nor recommended to remove information Select Fiter N
from these layers as this data may prove useful later o =
on. You should turn these layers off before deleting B g
garbage data. =i+ Types

Flash
3. Select Edit|Delete from the menus Py

Poly |
- or - Click the Delete icon #* on the toolbars ey

Slat
4. In the Selection Filter: Bock instance

. Driled Teat

» Setthe Mode to Window Mill Path

IVill Circle

»

8.
9.

Verify that all Types are
checked

Click and drag a selection
window around groups of
any obvious garbage data in
the workspace. Be careful
not to select any of the
circuit area.

H.H,
LimoE” "y
(1]

Click Yes to confirm each
deletion.

Select Tools | Pad
Removal | Stacked

Choose all layers and set the tolerance to .5 mils or .0005” and
choose OK.

Choose Analysis | Find Duplicates.
Select All layers and choose OK.

10. Expand the Analysis section of the navigator.
11. Right click the Duplicate Items folder and choose fix all.
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Note: After deleting all obvious garbage data it is a good habit to
review each electrical layer individually and look for any text or other
drawn objects that are not a part of the circuitry such as a board
outline or layer windows and delete these as well.
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Data Alignment

In this lesson we will describe how to use the Align Layers, Edit
Origin and Snap Pads commands to align all your data together so
that GT is able to accurately identify parts that are thru-hole
technology as well as finding all the correct nets across the various
layers.
Lesson objectives
In this lesson you will do the following:

» Use the Align Layers command

» Use the Edit Origin command

» Use the Snap Pads command

Estimated completion time

This lesson usually takes 15 minutes to complete.
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Align Layers

This command aligns layers for proper layer registration when
multiple layers are viewed simultaneously. Proper layer alignment is
also crucial to the successful creation of a netlist (A file containing
groups of X:Y locations for pads that are connected by traces)

If you wish to verify that your layers are correctly aligned, you can
check for layer-to-layer registration using the Analysis | DRC/MRC
command.

To align layers

1. Determine the layer to which all other layers should be aligned
with (the master layer).

Tip: When selecting a “Master Layer”, you should select a layer that is
already aligned with the majority of the other layers of your design.
Since layer alignment has to be done one layer at time, it is easier to
align a few layers with the vast majority of other layers than to align
numerous layers to the few that are misaligned.

2. Find an item on the master layer to use as a "base item", or
reference point.

Warning: Arcs cannot be used as reference points to align layers.

3. Select the Edit|Align Layers command.

4. Click on the item you chose as a master reference point. Use
the Selection Filter, if necessary.

5. Click on an item on each layer to be aligned that corresponds to
the reference point. As you select each item, it is highlighted
and you are asked to confirm your selection. The entire layer is
then aligned with the master layer.

Again, use of the Selection Filter may be helpful here. You may also
use the zoom in/out and pan hotkeys to make it easier to find the
master reference and corresponding items.

6. If you wish to select a new base item, press the Esc key and
repeat steps 4 and 5.

_OI‘_

When you are finished, press the Esc key twice to exit the
function.
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Activity: Align Layers

In this activity you will be aligning the layers of the IPC-Demo job.
With all layers turned on, your job should look like the image below.
Note that the drill layer is not aligned with the rest of the gerber
layers. We will correct this problem in this activity.

EE“E Edit View Add Setup Documentation Analysis Query Options Macro Tools Assembly User Help

P cu efoe X | am ] 4040 4D 4D #D af-po A T A A A =% - LEreescee g E ‘O+0-00
IDEH &7 ¢eFT@E o] T muQlam o BRERPE 28 BE RE S M
i LgazacLos ~|[® 011: Reund 00280 N EEEREEED e Rel ML HITF Y e - BT E N T E
Navigator - x| ] Colors -x
o 2 Layers - & Lyr F | D | Mame #
= T L1: 0423CPTP & Ehod) a2l
0423CPTR (=) 02 0423C
“ 0 Es:"””p & w33 W o423
-n 8 [v] 2 4 0423C
& oy . [ wer s I 0423
el wee L Q ¥ s 0423C
o L & SN | kS
W o L ¥~g I 0423
e L & P : W] werg B o423
e LS . (wsr% 10 [ I 0423C
L e [ 12 0 o223
w [ L uw Mg 1z [ Il o423
w-C& L oy W3 Bl os23c v
& L13:0423CDRL < >
e Apertures L]
@ Custom Apertures i |Sekectriter < x|
# B NCTools = =
L= e Bl ) -1+ o ml
o S
(i
Ttem Properties = | ~
Attribute Properties i
Type: No item selected.
| |
Lo = Main = _
— o —
View Window: enter first point.... " (Ct\Gerber Expert 7.0 [Redraw ON_[Undo ON_[Drc0 [Sel0 fInches @

Note: When executing commands such as Align Layers, it is often
AL necessary to zoom in and out of certain areas of the design while the

command is still active. Clicking on any Zoom Icon while
executing a command will cancel it! Some commands provide
their own zoom buttons inside their dialog box, but if no dialog is
provided the ‘+’ and ‘- keys on your keyboard should be used.

% 1. Select Edit|Align Layers from the menus

-0r -

€
@)

Click the Align Layers icon L= on the toolbars

2. In the Selection Filter, uncheck all the Types except
for Flash and Drill.

<
SRR

3. Select a reference point on the Master Layer.

.

» Keeping your mouse pointer over the text just
below the lower-left corner of circuit, press the
“+” key on your Num-Pad several times till you
can easily see corner tooling hole as seen here.

1,538,
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» Click on the tooling hole.
» Click OK on Choose Selection dialog
4. Select a reference point on the Layer to be aligned.

» Press the “-” key on your Num-Pad several times till you can
see the drill layers again.

» Keeping your mouse pointer over the lower-left corner of drill
layer, press the “+” key on your Num-Pad several times till you
can easily make out the different drill points.

easiest way to insure that you will be selecting the same reference

@ Tip: Choosing objects in one of the far corners of your circuit is the
points for both the master layer and the layer to be aligned.

» Click on the lower-left most drill point. Since the tooling hole
we chose on the master layer is also the lower-left most hole in
the circuit, this makes it certain that we are choosing the same
reference point on both the master layer and the layer to be

aligned.

» The Choose Selection dialog appears [EiEEEaEall
with two options available. (There are Properties Tyoe —
two layers that were misaligned from : ol 12
the rest, so you have an object from planoa e .
each layer listed.) Select the drill object
first.

» Click OK in the Choose Selection ¢ L
dialog. oK | Cancel |

5. The Align Layer function is still running, allowing you to align
multiple layers in a consecutive
sequence. Repeat step 4 selecting the
same reference point on the other
misaligned layer.

» Press the Esc key twice to exit the
function.
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Edit Origin
This command allows you to relocate the origin (0:0 point) of the

database. Follow the directions in the activity below using the IPC-
Demo job to demonstrate how to use this function.

Activity:To Change the Origin

£

1.

2.

Note: The text on the Top Paste layer indicates a tooling
hole as the intended origin for the circuit. This is why it
can be important not to remove text from non-
electrical/physical layers, it can be very helpful.

»

»

Select the Edit | Origin 'L command. The Change Database
Origin dialog box appears.

If you select “Database Updates Now”, your new origin
selection is immediately committed to the database, and the
film box (A continuous line that represents the film size.) and
data in the display are altered to reflect it. If you select
“Database Updates After Next Reload”, the new origin is
not committed to the database until after you save the
database and reload it. The film box will automatically relocate
to the origin you select, but none of the existing data (or
imported data) will reflect the new origin until after the reload.

Select Display This Dialog Only If Shift Key Is Pressed to
cause the dialog box to appear in the future if you press the
Shift key at the same time that you select the Edit | Origin
command. If you select this option, any setting you select above
becomes the default for the Edit | Origin command.

Click OK, and you are prompted to select a point to define the
new origin.
Select the new origin point

Hover your mouse pointer over the text just below the
lower-left corner of circuit, press the “+” key on your
Num-Pad several times till you can easily read the
text as seen here.

Set the Selection Filter as necessary

Hover your mouse over the tooling hole and press the
Home key. (This will snap your cursor to the exact center of
the selected object.)

0 Press the Esc key to exit the function when finished.
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Snap Pads

Unlike the Align Layers command, which shifts the entire layer based
on an individual reference point, the Snap Pads command examines
each individual item on a layer and aligns it to the nearest item on the
"golden" layer. This is useful if you need to cleanup low resolution
artwork that does not line up properly from layer to layer. Follow the

directions in the activity below using the IPC-Demo job to
demonstrate how to use this function.

Activity: To snap pads

Tip: Only visible layers are affected by the Snap Pads command.
Only flashed pads are affected by the snap pads command. If your
pads are not already flashed, return to this step after converting
drawn pads.

The most common problem is that your drill points will be slightly
offset, (even after performing the Edit| Align command), from the
pads they are paired with on your copper layers. The recommended
process therefore is to turn off all non-electrical/physical layers
and use the copper layers to snap your drill points into position.

1. Select the Edit|Snap Pads command. The Snap Pads dialog
box appears.

2. Select the Golden Layer whose pad =
or drill locations will be used as a
"master" reference to align items on Goldentayer:  |B -
the Snap Layer(s).

Snap Layer: 12 j

» Select the Top layer as your Golden

Layer_ Tolerance: 0.0050
3. Select the Snap Layers that contain Ok | Cancel |

pads or drills to be aligned with those
on the Golden Layer.

» Select All layers.

4. In the Tolerance box, enter the distance that coordinates of
items on the Snap Layer can deviate from the items on the
Golden Layer to be considered for alignment. Items within this
distance are aligned; items outside this distance are ignored.

Note: The recommended setting is between 5-10 mils, use 5 mils
(0.005 1n.) for now. If you use a number larger than 10 mils, you
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are risking that the command will snap objects together that are
meant to be separate.

5. Click OK. Any qualified data are aligned and you are informed
when the process is complete.

Review questions

1. What command will check for layer-to-layer registration?

2. What option should you select so your new origin selection is
immediately committed to the database?

3. What two conditions must exist for a layer to be affected by the
Snap Pads command?

4. What is the recommended setting for the Tolerance field in the
Snap Pads dialog?
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Draws to Flash Conversion

In this lesson we will describe the functions and processes used to
convert drawn objects in your gerber data to flashes. The DRC/MRC
processes will only recognize flashed apertures as pads so it is
required to run these processes on the Copper layers as a preliminary
step.

Lesson objectives

In this lesson you will do the following:

» Use the Automatic Draw-Flash Converter

» Use the Select Draw-Flash Converter to manage pads that
were missed by the automated process

Estimated completion time

This lesson usually takes 15 minutes to complete.
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Automatic Drawn Pad Conversion

The automatic drawn pad converter requires a paste or solder mask
layer with a corresponding top or bottom layer. For example, a "Mask
Top" or "Paste Top" layer requires a "Top" layer to exist. The mask
layer must have data on it, but it is not required that the mask data
be flashed. The openings on the mask layer are used to look for drawn
pads to be converted to flashes.

Note: If you do not have any mask layers, use the Select Draws
command discussed in the next section to convert your drawn pads to
flashes.

Follow the directions in the activity below using the IPC-Demo job to
demonstrate how to use this function.

Activity: To automatically convert draws to flashes

1. Select the Tools| Convert|Drawn Pads| Automatic command.
The Automatic Drawn Pad Conversion dialog box appears.

-Or-

Select the Automatic Convert Drawn Pads icon = from the
toolbar.

2. The Control Layer is the layer number of the solder or paste mask
layer that corresponds with the top or bottom layer that you wish
to convert pads on. Click the down-arrow button to select the
desired layer (to prevent an incorrect layer from being specified,
you cannot type a number directly into the box).

» Select layer 0423CMTP

s 1 O423CFTP

=210 D423C%

» If the selected Control Layer is a paste mask layer, the Paste Mask
Expansion option allows you to enter a value by which paste mask
openings will be oversized. Over sizing the openings may be
required, because often paste mask openings are smaller than the
corresponding pads on the top/bottom layer.
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Click the Select Layers button to specify one or more layers that
contain the drawn pads you wish to convert.

» Click the Select All button and it [

2]

selects all layers and changes to Name e v [pwe |
_ [ 8 L1:0423CPTP Paste Top | Off Yes
an Un-Select All button. 00 Goecers o o N
. . . [ &3 L3:0423CMTP Mask Top Cn es
» Click it again to deselect all [ as L4:0423CL01 To On Yes
]+ L5:0423CL02 Inner On Yes
layers_ [ & L6:0423CL03 Plane Neg | On Yes
O L7.04230L04 Plane Neg | On Yes
. [] »e= L8:0423CLO5 Inner On Yes
» Now click to select only the Top = L90423CL06 Bottom | On Yes
. g L10:0423CMET Mask Bot On Yes
and Bottom layers. Your dlalog O[] L11:0423C3BT Silk Bot On Yes
. . [ L12:Bord Bord o ¥
should look like the image on the = e =
right.
R .
Clle OK Select All ’Tl Cancel

Specify the Maximum Size, in the X
and Y dimensions that a group of draws may be, and still be
considered for conversion to a flash. If a group of draws exceeds the
maximum size, they will not be converted.

» Leave the defaults of 0.25” for this exercise.

Tip: Typically you will look for your largest aperture and measure its

dimensions to decide these values for each job. However, if it is too
large, greater than 1.0” in either dimension, you should not use
these values as you may risk converting objects that you don’t
want to be flashed.

The Tolerance controls how close
the replacement aperture must
be in size to the original draws,
to be considered a valid
replacement. If no replacement

?]x)]
Control Layer
3 lJ Paste Mask Expansion:

Conversion Layers

is found, then an error will be
logged.

» Leave the default of
0.0005” for this exercise.

6. Select the Replace Patterns
Rotated 90 Degrees option if you
wish to have items of the same
shape, which are rotated 90
degrees, converted also.

<Multiple Selected = Select Layers. ..

Options

Maximum Size X: | 0.2500

0.0005

¥ Replace patterns rotated 90 degrees

% |D.ZSDD

Tolerance:

V¥ window control layer data

oK 'E | Cancel |

7. Select the Window Control Layer Data option if you want to
convert only pads in a specific area. This is useful for designs that
have text blocks or other data outside the actual board area, as
excluding that extraneous data will speed up the process.
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8. Click the OK button.

» If you did not select the Window Control Layer Data option, the
conversion process begins immediately. If the option was
selected, you must select two points to define the area to be
processed.

9. When the process is complete, a message is displayed indicating
the number of converted pads.

Automatic Draw Conversion |

1 ) Converted 701 drawn pads.

-

» If you selected the Window Control Layer Data option, you may
select another area to process, or press the Esc key to end the
function.

10. If no appropriate replacement aperture is found to replace a
drawn pad, then an error is logged. An error is also logged if
a mask opening exists, but no drawn data was found in the
corresponding location on the conversion layer.

Automatic Draw Conversion X

\__?(f Errors were found during processing of mask check areas, add them to the analysis manager?

k{ | Mo ‘

ES
b

» Click Yes to add these errors to the analysis manager.

11.Repeat this process again for the IPC-Demo job, but select
layer 0423CMBT as the control layer this time.
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Select Draws

This function converts drawn pads to flashes, based upon data that
you manually select for conversion. This function is useful for dealing
with any unconverted pads left over as a result of errors from the
automated process described in the previous activity. It is also your
backup option if you do not have a Solder Mask or Paste Mask layer to
use for the automated process.

Follow the directions in the activity below using the IPC-Demo job to
demonstrate how to use this function.

Activity: To convert draws to flashes by manually
selecting draws

1. Begin to review the errors from the previous activity as described
in step 10 above.

» You can review these errors using the Error Analysis Manager
in the Navigator.

Tip: Prior to reviewing the errors, if you turn all layers Off, the
analysis manager will automatically turn on the effected layer(s) of
an error and zoom your view in when you click on the error in the
list. This will give you an uncluttered view of the effected objects.

& Layer Sels
- ey Assembly
€} Embedded Passives
=1 89 Analysis
=153 Auto Draw Conversion
L e
9 € D2 Apet.
G €3 D2F No Apet.
G €3 D2F No Apet.
G €3 D2F No Apet.
G €3 D2F No Apet.
G €3 D2F No Apet. =

[« ol
= 0uia

Item Properties - x

Attribute Properties
Type Mo item selected.

2. After selecting the first error, select the Tools | Convert | Drawn
Pads|Select Draws command.

-Or-
Select the Convert Drawn Pads icon = from the toolbar.

3. In the Selection Filter settings, make sure that the Type is set
only to Draw and the Mode is set to Window.
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4. Under Layers in the Selection Filter, uncheck the mask layer so
that it will be visible, but not selectable. Otherwise the converter
will find both objects on the two layers and it cannot convert more
than one unique object simultaneously.

5. Select one occurrence of the drawn pad that you wish to convert.
The Convert Drawn Pads dialog box appears.

highlight box around the pad that was affected by the error you
clicked on. You can use this box as a template for where to click-
and-drag your selection window.

@ Tip: You may notice that the Error Analysis Manager created a

» The system locates all drawn pads identical to the one you
selected. The Calculate Pad Size area displays information on
the selected pads to be converted.

6. Select how you want the draws replaced.
» Create True Size/Shape Custom Apertures

Select this option if you wish to have selected items converted to a
single custom aperture, (Special user-created shapes that are
normally used as flashes. They can be created or modified in the
Custom Aperture Editor.), with the same appearance.

0 Use this option for the IPC-Demo job.
» Create Standard Apertures

Select this option if you wish to have selected items converted to
one aperture of the specified shape and size. Select the Shape and
Size of the aperture you wish to use. If an aperture of that size and
shape already exists, it is used. Otherwise, a new aperture is
created. If you also select the Replace Patterns Rotated 90 Degrees
option (see step 5), then up to 3 apertures may be created.

» Specify D-code

Select this option if you wish to have the selected items converted
to an existing aperture. Specify the new D-code number for the pad
created by the conversion. To view the Aperture Table, where you
can create or edit apertures as necessary, click the Edit
Apertures button.
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Select the Replace Patterns Rotated 90 Degrees option if you
wish to have items of the same shape, which are rotated 90
degrees, converted also.

» We will use this option for the IPC-Demo job.

Select the Use Net Connectivity option if you wish to only
convert pads that are on the same net as the example pad that you
selected.

» We will NOT use this option for the IPC-Demo job.

Select the Include Isolated Items option if you wish to have
items that are not part of a net (isolated pads) checked for possible
conversion.

Set the Tolerance to increase the system's ability to recognize
pads that are the same size, and account for minor variances in
drawn data, you can specify a value. By doing so, you relax the
criteria for determining which pads are the same sizes; pads whose
sizes are within the tolerance value are determined to be the same.
Usually a value of 0.0005 inches is sufficient.

Convert Drawn Pads El El

Calculated Pad Size: 10,0750 : 0.2020 - from 38 items

¥ Replace patterns rotated 90 degrees Tolerance: |0.0005

[ Use net connectivity [

Replacement Method

(™ Create true sizefshape custom apertures

{* Create standard apertures
Shape: | Cblong - Change Size: | 0.0750: 0.2090

™ Specfy D-Code

D-Code: ’7 j

Cancel |

11.

After you make your selections and click OK, all occurrences of
any matching drawn pads are located and you are asked to confirm
whether to continue.

» Click OK to confirm the conversion

GerbTool Training Guide 51



GerbTool
Training Guide

12. Repeat this process as necessary while reviewing the errors that
were found during the automated conversion process or if you are
using this process because you have no mask layers available.

} TheI’e Should Only be 2 | e ot e At geno Coqumentaton sceives Query Ootons Mo Tocke Assembly user beb

- S I A O

pads that you need to || bl et
process in total for the |=ce=s e T me
IPC-Demo job. The FEmmm || @
other errors are the
result of bits of traces
found within the mask

areas as seen here.

Tip: The command stays
active after each

oooooOo ., E¥Ry;

conversion, So you can
simply click on the next
error in the Analysis
Manager and continue
selecting the next set of
draws.

» Press Esc key to exit
the command.

Review questions

1. What are the layer requirements for using the Automatic Drawn
Pad conversion?

2. What happens if no appropriate replacement aperture is found to
replace a drawn pad?

3. In What situation should you use custom apertures when running
the Select Draw command?

GerbTool Training Guide 52



GerbTool
Training Guide

Netlist Comparison

Graphical netlist comparison allows you to visually compare your
design data against the original netlist. GerbTool performs the
comparison automatically, and all violations are stored internally like
DRC/MRC and DFF violations. This means you can quickly scan
through and fix connectivity issues.

As an aid to those who wish to compare a netlist created from Gerber
data back to an ODB++ or PADS ASCII database netlist, the

File |Import | Netlist | ODB++ and File | Import | Netlist | PADS
ASCII commands import only the netlists from those databases.

Lesson objectives

In this lesson you will do the following:
» Generate an internal netlist
» Import an IPC D356 netlist

» Use netlist compare to find differences between the CAD netlist
and the gerber data

Estimated completion time

This lesson usually takes 15 minutes to complete.

GerbTool Training Guide 53



GerbTool
Training Guide

Compare Netlists

Follow the directions in the activity below using the IPC-Demo job to
demonstrate how to use this function.

Prior to netlist generation and netlist comparison, the following steps
need to have been taken:

Using the Setup | Layers command or the Navigator, make
sure that each layer is "tagged" with the correct layer type.
This is required so that the system understands what each
layer is.

Make sure that any extraneous data on your electrical layers
that are outside the perimeter of the board, such as title blocks,
targets, crop marks, etc. is removed.

Tip: We recommend that any documentation for the board be
done on a separate Drawing layer. If you wish to keep the data,
placing it on a drawing layer assures it will not interfere with
any processing, such as netlist extraction.

If you have any drawn pads in your database, select one of the
Tools | Convert | Drawn Pads commands to convert them to
flashes.

Use the Analysis | DRC/MRC command to make sure your
layers are properly aligned. If any layers are misaligned, you
can use the Edit| Align Layers command to align them.

Use the Tools | Pad Removal | Stacked command to remove
any redundant pads.

An NC layer with through-hole drill information is necessary to
determine layer to layer connectivity, as well as direct
connections to plane layers. The system will automatically
display your NC layer in the Thru-hole Drill Layer box. If you
want to select a different NC layer, click the arrow button and
select the layer. If you do not supply an NC layer (select
"None"), the netlist extract function will use the Aperture Table
Type field to determine whether each pad is SMT or not.

Activity: To compare netlists

1.

2.

Select the Tools | Netlist | Generate command to extract a
netlist from your data.

Select the 0423C.IPC (external) netlist using the

File | Import | Netlist | IPC-D-356 command.
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After you import the netlist, a new External Net layer is
created. Viewed by itself, this layer appears to contain no data.
However, this layer contains the external netlist information,
and links the external net points to the appropriate
top/inner/bottom layer net test points. To view the points, turn
on the associated top, bottom, and inner layers, and the
external net layer. The net points are displayed in four ways
for easy reference. Downward pointing triangles represent
test points accessible from the top side of the board. Upward
pointing triangles represent test points accessible from the
bottom side of the board. X’s represent test points which are
accessible from both sides. Triangles pointing to the side
represent points which are only accessible from the inner
layers (for blind and buried technology designs).

Select the Analysis | Netlist Compare command.

Select the Shorts and Opens checks and click RUN.

After performing the analysis, discrepancies are automatically
displayed in the Navigator, which you may use to view the
errors in the workspace and print reports.

Double-click on the error in the Navigator to view it in the
workspace. The GerbTool internal net in question highlighted,
and zoomed to fit the screen. The external net points are shown
in a unique color for each net.

Tip: The external net point graphic colors are arbitrary. If
necessary, you can change the highlight, draw, and flash colors
for the layers you are looking at for better contrast and easier
visibility.
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7. No errors are found. If GerbTool finds an error, right click the
error and choose properties, an image similar to the following
1s displayed:

| List Emor l
Name: Met Short
Id: 1462

Fix State: Urficable

Rule: n/a

Description
Bxtemal Nets:
GMND

NAC

Intemial Net: 252

8. Find the precise location of the error more quickly by right-
clicking on the error in the Navigator, and selecting the Pin-
Point Error command.

Tip: If there is a fix to the data needed, you can now change the
data as necessary. Once you have done so, you should then re-
run the Netlist Compare command to verify that the fix was
accurate. Once no more errors exist, you can use the

Tools | Netlist | Apply External Net Names command to
apply the external net names to the database, if you wish.

Review questions

1. What are the layer requirements for netlist comparison?

2. What happens if there is no Thru-hole drill layer present?

3. Where are the netlist compare errors found?
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4. How can you find the actual location of the error?
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Creating Stencils

In this lesson we will describe the functions and processes used to
enhance the Paste Stencil openings in your Gerber data for improved
paste application.

Lesson objectives

In this lesson you will do the following:

» Use the Paste Optimize command to take care of under sizing
the paste layer.

» Use the Stencil tools to create specially shaped paste openings
such as home plates and melfs.

» Use the Window Panes macro to create specially shaped paste
openings.

Estimated completion time

This lesson usually takes 35 minutes to complete.
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Optimize Paste Mask

This function automatically under sizes existing paste mask openings
on a Paste Mask layer based on the rules given. This function
operates on flashed pads only, so in our IPC-Demo design we will need
to convert the paste layer to flashed pads first before under sizing. If
no Paste layer exists in your design, Generate Paste Mask instead of
Optimize. The settings and options are nearly identical for both
commands..

Follow the directions in the activity below using the IPC-Demo job to
demonstrate how to use this function.

Activity: To optimize a paste mask

‘ﬁ] 1. Use the Tools| Convert|Drawn Pads|Automatic and
Tools | Convert | Drawn Pads|Select Draws commands to
convert your drawn pads to flashes on the paste mask layer as
in the previous lessons.

2. If you want any items in your database ignored during the
mask optimization process, create a Select Group of those
items.

3. Select the Tools | Paste Mask | Optimize command. The
Optimize Paste Mask dialog box appears.

4. Select optimize the Top Mask.

Note: The system uses the Thru-hole Drill Layer specified to
identify the different types of pads in your design. It will process
any pad that is SMT. If you do not have a thru-hole drill layer,
then the system will use the Aperture Table Type information.

5. In the Maximum Errors box, specify the maximum number of
allowable errors as 1000. If the optimizer reaches this error
count limit, it stops logging errors and warns you that the limit
was reached. This limit is provided in case you enter an
undersize amount that is not appropriate for your design.
Specify your Desired Undersize as 6 mils.

Select the Round Corners option for the openings, define the

corners as 10 percentage of the shortest side of the aperture.

8. The Location Alignment specifies the maximum misalignment
allowed between the location of the mask opening and the
corresponding pad on the electrical layer. Set this to zero.

9. Select the Detect Fine Pitch Pads option to have the system
analyze pads for fine pitch conditions (round pads are ignored).
Choose Center to Center, spacing of 25 mils. Leave the default
undersize values of 6 mils perpendicular and 3 mils parallel.

N
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11.

12.

Select the Ignore Pads On Electrical Layers Less Than option
and select a minimum pad size of .025.

Select the Fix Errors option. Regardless of whether you have
the system fix any errors, they are all logged in the Navigator,
where you can view them, print reports, and fix/unfix the
errors. The following possible errors are reported:

Missing Electrical Pad There is no pad on the electrical layer
corresponding to an opening on the mask layer. To fix this, the
mask opening is deleted.

Missing Mask Opening There is no opening on the mask
layer corresponding to a pad on the electrical layer. To fix this,
a mask opening is added.

Misalignment Error The opening on the mask layer and its
corresponding pad are misaligned by a value greater than the
Location Alignment value you specified. To fix this, the mask
opening is moved to the same location as the pad.

Mask Opening Minimum Undersize Error The mask
opening is not undersized by at least the minimum specified
undersize. To fix this, the mask opening is undersized by the
specified amount.

QOptimize

[ Maximum Errors: 1000
Thru-hole Drill Layer: |1 j

Undersize

O] t
Desired: | 0.0060 [+ Round Corners: - sresn lmi

Armount

Location Alignment
Mask Opening to Electrical Pad Tolerance: 0.0000

[+ Detect Fine Pitch Pads

" Edge to Edge {* Center to Center Spacing: | 0.0250
Undersize: Perpendicular: | 0.0060 Parallel: 0.0030

Data Control
[+ Ignore pads on electirical layer less than: 0.0250
—

[ Convert drawn mask layer

[w Fix Errors

Ok | Cancel
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15. After making your selections, click OK to execute the
optimization.

(IEHLERUTLRRUED R

Review questions

1. What are the layer requirements for using the Optimize Paste
Mask Tool?

2. What happens if there is no Thru-hole drill layer present?

3. What would you do if there were no Paste Layer to optimize?
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Create special stencil shapes

In the following activities we will use the Stencil Shapes tool which
allows simple rule based conversions of stencil pad pairs to common
IPC stencil shapes and a Window Panes macro designed to create
ideal solder paste conditions for certain component land to pad
situations. Creating special stencil shapes should occur after the
general paste reduction has been applied.

Follow the directions in the activity below using the IPC-Demo job to
demonstrate how to use this function.

Activity: Setup stencil shapes
1. Select the Tools | Stencils | Setup Shapes command, and click

the new button.
2. Enter the values from the screen shot below and select OK.

MNew Stencil Shape @g

Shape Mame: | InvertedHP

Shape Type: | Inverted Home Plate j | Justification
e ssns e . r

Set Sizes by: " Amount % Percentage:

Increase/Decrease Heights |0
Increase/Decrease Width: |0 r r
Inset/Protrusion Length: 20

Inset Width: 0
Corner Radius: 10

[ [ Reverse Direction

| Ok Cancel

3. Select OK again on the Stencil Shapes Setup Dialog.

4. Turn on the visibility of the Silk Top Layer.

5. Select the Tools|Stencils | Manual Conversion command to
teach the system which stencil shapes you want to associate
with which original openings over pad pairs. Select the pair of
pads marked as X1 on the Silk Top Layer. After selecting the
pair of stencil shapes, click “No” when you are asked whether
you want to convert the matching openings.
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6. Next, Select the pair of pads marked as L2 on the Silk Top
Layer. After selecting the pair of stencil shapes, click “No”
when you are asked whether you want to convert the matching
openings.

The tool will save the assignments you have made, but the
openings will not be converted at this time.

7. Select the Tools | Stencils | Automatic Conversion command
and specify which paste mask layers you wish to convert, what
destination layers to place the stencil data on, and convert all
the openings.

Tip: Once you have completed
steps 4 and 5, you can save the
stencil definitions and
associations to a file by clicking
the Save button in the Automatic
Stencil Conversion dialog box.
The next time you want to
enhance a stencil using the same
stencil shape definitions and
associations, you can skip steps 3
and 4 above. Just select the
Tools | Stencils | Automatic
Conversion command, click the
Load button to load the file, and
run the conversion.

Activity: Window Panes

1. Select the Macro | Load command and choose the
WISE_MultiPanes.mac and choose open.

2. Select the Macro | Run command
(“M” on your keyboard) and select
“MultiPanes” in the Macro Name
listbox.

3. You are prompted to enter an input
layer. Type the number of your Paste
Layer and select OK.

4. Window around the large ground pad
for U18 as shown in the image to the
right:

5. You are prompted to enter a gap size.
Enter .025.
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6. Enter a number of column stripes: 2

Enter a number of Row stripes: 3

8. Select Yes to convert all matching shapes, although in this
design there will be only one match.

9. You are asked whether or not to convert another. In this case
we will choose No as there are no other shapes on this design
that look as though this technique should be used.

10. Your pad should look like the image below:

=~

Review questions

1. Why are home plate and inverted home plate shapes used?

2. What is the reason to use the window panes macro?

3. Should you create special stencil shapes before or after general
paste reduction has been performed?
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DRC/DFM Analysis

The GerbTool Analysis functions are used to find any flaws in your
design prior to manufacturing. Using rules that you specify, the
system analyzes your design, finds errors, and determines the best fix
for those errors. You can then review the errors in the workspace,
print error reports, fix the errors yourself, or have the system fix the
errors for you.

For maximum efficiency, all your rules can be saved for use in future
designs and each check can be run at the same time.

Lesson objectives

In this lesson you will do the following:
» Use Analysis to collect information about the design.
» Setup DRC/DFF checks to find problems in the design.
» Review and fix problems found during Analysis.

Estimated completion time

This lesson usually takes 35 minutes to complete.
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Information Checking

This section of the Analysis checks provides information about your
design that can be particularly useful in cost estimation and process
evaluation. The available checks are:

e Min Air Gap - Reports the shortest distance between any two
items in the design.

e Conductive Layer Count - Reports the total number of
conductive layers.

e Board Size - Reports the extents of the Border layer, if one
exists. Otherwise the extents of the conductive layers is
reported (drawing and other graphical layers are ignored).

¢ Hole Count - Reports the tools used on each NC layer, and the
number of holes (hits) created by each.

¢ Hole Size Count - Reports the number of tools used on each
NC layer (does not report tool numbers or hits).

e Buried Vias - Reports the upper- and bottom-most (start and
end) layers for buried vias. Blind and Buried layer sets must be
defined in order to run this analysis.

¢ Blind Vias - Reports the upper- and bottom-most (start and
end) layers for blind vias. Blind and Buried layer sets must be
defined in order to run this analysis.

e Min Pad/Drill - Reports the minimum annular ring spacing
from copper pads to plated through-hole drill hits.

e Min Drill/Drill - Reports the minimum spacing between drill
hits.

e Min NPTH/Copper - Reports the minimum spacing between
non-plated through-hole drill hits and copper on external and
internal layers.

e Min Pad/Pad - Reports the minimum spacing from one pad to
another for each conductive layer.

e Min Pad/Trace - Reports the minimum spacing from a pad to
a trace for each conductive layer.

e Min Trace/Trace - Reports the minimum spacing from one
trace to another for each conductive layer.

e Min Pad/Mask - Reports the minimum annular ring spacing
from mask openings to their corresponding copper pad, on the
top and bottom layers.

e Min Thermal/Drill - Reports the minimum annular ring from
thermal reliefs to plated through-hole drill hits.

e Min PTH Pad Size - Reports the size of the smallest pad that
has been pierced by a plated through-hole drill hit, for each
conductive layer.

e Min Trace Width - Reports the smallest trace width in the
design.
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Min SMT Pitch - Reports the minimum center-to-center
spacing of SMD pads. A pad must be identified as SMT in the
Aperture List in order to be checked.

Legend on PTH Count & Legend on NPTH Count -
Reports the number of occurrences of the silkscreen legend
touching pads on the top and bottom layers.

Missing Hole Count - Reports the number of instances where
a through-hole pad on a conductive layer appears to be missing
a drill hit.

Mill Path Length - Reports the total linear distance each tool
travels, per NC layer.

Max PTH Registration - This shows the greatest amount of
misalignment of data on drill and conductive layers. It reports
the maximum spacing of plated through-hole drills (on an NC
layer) from their corresponding pads (on a conductive layer).
Exposed Copper Count - Reports the number of occurrences
of traces exposed by adjacent mask openings.

Copper Sliver Count - Reports the number of occurrences of
copper slivers. Any areas of copper that are less than the Size
you specify will be considered possible copper slivers.

Mask Sliver Count - Reports the number of occurrences of
mask slivers. Any resist areas that are less than the Size you
specify will be considered possible mask slivers.

Activity: Perform Information Checking

In order to perform analysis functions, each layer type must be
set correctly, and the layers that are to be checked must be
selected in the “Layers to Check” area of the Analysis Setup
Dialog. Only conductive layers and the Through Hole Drill
Layer need to be selected, Mask, Paste, Silk and Blind and
Buried drills will be found automatically if they present in the
design with their layer type set.

e

Open the the Analysis Setup by clicking Analysis | DRC/MRC.
Click the “Load...” button in the lower left corner of the dialog.
Select the Training.rul file and click “Open”.

Click “Run” to run the information checks defined.
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5. After a few moments the following dialog will pop up:

6. Open the Analysis tree in the Navigator, and expand the
results.

7. Right click on a particular check such as “Conductive Layer
Count” and choose properties to view the results of an
individual check:

Name: Conductive Layer Count

Run ]Pass ||'ff

Id: 7616
Fic State: Unfoble

Rule: n'a

Description
Layer Count: &

”

8. Right click on “Information” and choose “Print All” or “Report
to get a single line by line report of all the information checks
performed.

Review questions

1. What are the layer requirements for using the Analysis checks?

2. What happens if there is nothing selected in “Layers to Check”?

3. How can you generate a report from the Analysis results?
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DRC/DFF Checking

In the following activities we will use the Analysis tool which allows
simple rule based checks to determine the manufacturability of your
design. This process can help to catch design problems missed by the
CAD system (DRC checks) and find manufacturability issues that the
CAD system is not capable of checking (DFF Checks). The following is
a comprehensive list of the currently available checks:

DRC (Design Rule Check)

e Pad/Pad - The minimum spacing allowed between pads.

e Pad/Trace - The minimum spacing allowed between pads and
traces.

e Trace/Trace - The minimum spacing allowed between traces.

e Border - The minimum spacing allowed between any item and
the border.

e Min Pad - The minimum pad size allowed.

e Min Trace - The minimum trace size allowed.

e Stubs - A trace stub is any trace that touches a pad or trace on
one end, but does not on the opposite end.

¢ Drill/Drill - The minimum spacing required between adjacent
drill locations.

e Drill Annulus - The minimum annular ring required between
conductive layers and drill layer.

e Drill/Copper - The minimum space required between copper
entities and drills. Separate tolerances are available for plated
through-holes (PTH) and non-plated through holes (NPTH).

e Pad/Top Mask & Pad/Bot Mask - The minimum annular
ring required between top/bottom side pads and the top/bottom
solder mask. (Only checks the size of existing openings, not
whether there is an opening missing for a pad. Use the Missing
Top Mask and Missing Bot Mask checks to find missing
openings, if desired.)

e Drill/Top Mask & Drill/Bot Mask - The minimum annular
ring required between the drill layer and the top/bottom solder
mask.

e Missing Top Mask & Missing Bot Mask - Checks for pads
on the top/bottom side conductive layer without openings on
the top/bottom solder mask.

e Pad/Top Silk & Pad/Bot Silk - The minimum clearance
required between top/bottom side pads and the top/bottom
silkscreen layer. (You can use the Tools | Fix SilkScreen
command to remove silkscreen data from pads). If you select a
"Mask: Yes" property, then the silkscreen layer is instead
compared to the corresponding solder mask layer.
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e Missing Drill - Checks for pads that do not have a
corresponding drill hit.

e Coincident Drill - Checks for drill hits that are in the same
location but are different sizes.

e Redundant Drill - Checks for drill hits of the same size that
are in the same location.

e Mill Path - Checks compensated mill pats for errors
introduced by the compensation: arcs that implode, paths that
cross over themselves, and any break tabs that become invalid
because the compensated path is now too short for the tab to
fit.

DFF (Design For Fabrication)

e Acid Traps - An acid trap is an area where etching solution
accumulates but does not flow out during manufacturing. This
causes over-etching, which hurts yield. This analysis detects
potential acid traps in your design. Any areas where acid is
likely to accumulate that are smaller than the Size you specify,
and any items (traces, pads, etc.) that form an Angle smaller
than the one you specify, will be considered possible acid traps.

Tip: Because the acid trap analysis looks for areas that are not fully
enclosed, it is recommended that you run the resist sliver analysis in
conjunction with this, for a thorough check of your design.

o Copper Slivers - Copper Slivers are areas of copper that are
so narrow that they will likely flake off. This command detects
those potential slivers on the selected conductive layers in your
design. Any areas of copper that are less than the Size you
specify will be considered possible copper slivers.

¢ Resist Slivers - Similar to acid traps, resist slivers are small
areas of resistive material that have a surface area too small to
adhere to the board, and can therefore flake or peel off. Where
acid traps are open at one end, resist slivers can be fully
surrounded by copper. Depending on your process, the resist
slivers test will often find items that are also considered acid
traps or pin holes. The Resist Slivers analysis may be more
applicable to those using a plate-up photo resist process instead
of an etch-back process. Resist areas less than the value you
specify are considered resist slivers.

¢ Top Mask Slivers & Bot Mask Slivers - Solder mask slivers
are areas where the resist is so narrow that they will likely
flake off, float, and redeposit themselves in an area that might
be soldered later. Any resist areas that are less than the Size
you specify will be considered possible mask slivers.

GerbTool Training Guide 70



GerbTool
Training Guide

e Isolated Thermals - Over-etching of surrounding items can
result in a thermal being isolated from the rest of a negative
plane. This analysis function allows you to oversize the data on
the negative plane layers by a specified amount, and determine
its effects on the connection of the thermal to the negative
plane. You specify the amount of Over Etch that you wish to
apply to the data on the specified plane layer.

Warning: A thermal can be considered isolated by virtue of its design.
For example, if a thermal has ties that are 2 mils wide, and the Over
Etch is specified as 1 mil or larger, the thermal is isolated.

e Starved Thermals - The starved thermal analysis verifies
whether each thermal connection to the negative plane is valid,
or has been constricted by adjacent data that is too close (or
overlapping). You specify the Percentage of the thermal's tie
width that can be unblocked by objects. This makes the
clearance check relative to each thermal's tie width. The
thermal is considered starved if the connection from the
interior of the thermal to the exterior, measured across the
minimum distance between the cutouts of the thermal and any
other nearby data, is less than the specified value. The Clear
value is how many thermal ties must be clear in order for a
thermal to be considered not starved. If you specify 0, all ties
must be clear. If you select 1, one tie must be clear.

Warning: Be aware of the number of ties in all the thermals in your

design. If you select 4 as your Clear value, and have thermals with 2
ties, then those thermals would automatically be flagged as starved,
even if both of their ties are clear. If you have several different types
of thermals, it is recommended that you leave the Clear value at 0.

e Top Solder Bridges & Bot Solder Bridges - Openings for
pads on a mask layer may be oversized too much, and expose
an adjacent trace or another conductive object. The copper for
that pad may accidentally get too close during fabrication, and
create an unwanted connection, or bridge, to the adjacent
object. The Bridge Distance is the distance between the pad
and objects in the same mask opening, where the solder can
possibly create a bridge. If the adjacent object closer to the pad
than this distance, it will be identified as a possible bridge. The
Position Tolerance tests for shifting of the placement of mask
openings. It oversizes mask openings by the amount you
specify, to check if other conductive objects are then exposed by
the mask opening. If an object is exposed, and is also within the
specified Bridge Distance to the pad, then an error is logged.
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Pin Holes - A pin hole is a void in an area of solid copper that
can cause acid to pool and over-etch the surrounding copper
(similar to an acid trap), or can cause resist flakes, potentially
causing conductivity problems. Pin holes often result from
inaccurate vector-drawn data that leaves tiny voids between
the over-lapping draws. You specify the maximum Size of the
pin holes to be detected -- areas which are less than this value
will be considered pin holes.

SMD Pitch - Checks the center-to-center spacing of adjacent
SMD pads, to determine if they are too close. A pad must be
identified as SMT in the Aperture List in order to be checked.
SMD Spacing - Checks the edge-to-edge spacing of adjacent
SMD pads, to determine if they are too close. A pad must be
identified as SMT in the Aperture List in order to be checked.
Layer Registration - Checks your drill layer against the top
mask and any other conductive layers you select. If two items
are within the tolerance distance you specify, they are
considered to be at the same location. The errors reported are
those items that, if you use the Edit|Align Layers command or
GerbTool's auto-fix feature to align the layers based on them,
will result in 95% or more of the other items on the layer being
correctly aligned as well.

Follow the directions in the activity below using the IPC-Demo job to
demonstrate how to use this function.

‘ﬁ] Activity: Performing DRC/DFF Analysis

O Lo

o

Open the the Analysis Setup by clicking Analysis | DRC/MRC.
Add check marks to the DRC and DFF passes.

Unselect the Information pass (since we've already run it).
Click “Run” to run the checks defined for these passes.

After a few minutes A dialog opens reporting that errors were
found.

Open the Analysis tree and expand the DRC checks.
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As you can see, there are several pads that break the rule set up in the

check.

8. Click on the first Pad to Top Silk error to highlight:

P Demagtd G

i

o

e Propeses

Amvbute | Properses
M e seeeted,

For Help, press F1
_—r

5

11381 [RIElS

L]

Desktop Redraw ON Undo ON Drc 2566 Sel0 Inches @
= —_—

GerbTool Training Guide 73



GerbTool
Training Guide

9. Right click the error and choose fix:

P Demagid G

| B tot iew Agd Setup Dogumentasicn
oW &¢ e FE
llegnAwensotod

|EPEE o2l 1] @B @A
| o3 ¥ | em o] 3o o
o= BT

gt

Pt Top S
Padta Tog 5

’w Main

For Help, press F1
_—r

i, MOD C\Users\stan’ Desktop Redraw ON Undo ON Drc 2566 SelD Inches @
T —

10. You may right click on the DRC folder in the tree and highlight
all, or fix all to handle these operations en mass.

11. Expand the DFF folder and click the first Acid Trap error to
highlight:

P Demagid G

| B tot iew Agd Setup Dogumentasicn
loew @a¢levma
llegnAwensotod

Al

X -

x

1180 IREISS

For Help, press F1
_—r

i MOD C\lsers\stan’ Desktop Redraw 0N Undo ON Drc 2566 Sel0 Inches @
— —
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12. Blgm%ciick the error and choose “Fix”:

I!‘= Lot Yeew Agd Jetup Dogumentstion Analysis Query Options Mscre Took User Meip
loFa @t crao |z
letAwonéentade
|EVESE o #i 1] B A s
| o | ems] 0m e

| Lnoszim

gt

ur

_’w_-ﬁ -;m

T

#oer W oo

For Help, press F1 i, [MOD C\sers\stan Deskiop Redrew ON Undo 0N Drc 2566 5el0 Inches @
_—r e L ——

The fix adds copper to smooth the area so that over-etching will not
occur due to the acid trap condition.

13. You may right click on the DFF folder in the tree and highlight

all, or fix all to handle these operations en mass.

Review questions
1. Why are DRC checks used?

2. What kind of problems do DFF checks find?

3. How can I apply all the possible fixes at once rather than clicking
each one?
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Panelization

Panelization is the process of creating an array of your PCB for a
manufacturing panel. This allows multiple PCBs to be created at one
time, optimizing material usage and shortening your manufacturing
turnaround time.

Lesson objectives

In this lesson you will do the following:

» Use Advanced Panelization to create a finished panel for
manufacture.

Estimated completion time

This lesson usually takes 25 minutes to complete.
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Advanced Panelization

GerbTool's Advanced Panelization allows you to panelize single or
multiple designs, and lets you store an unlimited number of panel
templates so you can use the same panel configuration for multiple
jobs.

Activity: Perform Advanced Panelization

In order to perform Advanced Panelization, you must have each
design already saved as a GerbTool .gtd database (this command does
not automatically operate on the data currently loaded in the
workspace, unless it is already a panel or panel template). Coupon
placement, venting and thieving, pinning holes, and title blocks are
supported, as long as those elements have been saved as individual
.gtd files.

Essentially, all panel elements are just seen as individual images by
GerbTool, that you can add, rotate, and repeat however you wish. As
long as you prepare your data properly, panelization is a quick and
easy process.

1. Select the File]New command to start with an empty database.

2. Select Tools|Panelize|Advanced.

3. The Panel size should be 18”x24”, set it to this value if it is
different.

4. Select the “Image” Tab.

5. Click the “New (Insert)” button.

Advanced Panelization

2 e 6. Click the “...” button to browse

Panel Image ] Layout ] Robber Bars ] Venting & Thieving ]

Image Files o

¥ Change Anchor Point from Image origin to
. @,

Border
(+ From Border Layer - Use::
(¥ Centerline
" Edge

" Dat= Extents

Layer Mapping...

Image File: IPC-Demo.gtd (5925.0 x 3954.0)
Panel Size:  18000.0 x 24000.0

]

for your “IPC-Demo.gtd” file and select
“Open”.

7. Place a check mark in the box
next to “Change Anchor Point from
Image origin to”.

8. Select the Center Anchor Point.

9. Inthe “Border” area, select
“From Border Layer - Use” and
“Centerline”.

10. Click the “New (Insert)” button.

11. Click the “...” button to browse
for your “612p_250_pin_a.gtd” file and
select “Open”.

Cancel ‘
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12. Place a check mark in the box next to “Change Anchor Point from

Image origin to”.
13. Select the Center Anchor

Point.

Advanced Panelization

14. In the “Border” area,
select “From Border Layer

Image Files

Panel Image ]Layout ] Robber Bars | Venting & Thieving ]

- Use” and “Centerline”.

15. Click the “New (Insert)”
button.

16. Click the “...” button to
browse for your
“612p_cpn_a.gtd” file and
select “Open”.

17. Place a check mark in the
box next to “Change

Border

Anchor Point from Image j;:n:er"ne
Ol’igin t0". " Data Extents

18. Select the Center Anchor
Point.

C:\Users\stan'\Desktop\IPC-Demo.gtd
C:\Users'stan'\Desktop'6l2p 250 pin_a.gtd

¥ Change Anchor Point from Image origin to

* From Border Layer - Use:

(" &

Layer Mapping...

19. In the “Border” area,

o]

Cancel |

Image File: 6l2p_cpn_a.gtd {4. 100 x 0.500)
R Panel Size:  18.000 x 24.000

select “From Border Layer

- Use” and “Centerline”.

Tip: You do not need to worry about the
layer order in the original .gtd files. The
first file you bring into the panel establishes an
initial panel layer structure. As you add new
images to the panel, you can then use the Layer e 65006 [otton]
Mapping function to match each image layer to

the appropriate panel layer, and create new

panel layers as necessary. In the image to the

right, all layers are automatically mapped
appropriately in this example.

20. Select the “Layout” Tab.

21. With the “612p_cpn_a.gtd” file
highlighted, select “Manual
Placement”, and change the
“Number of copies” to 1.

22. Use the right mouse button to click
on the green image in the preview
panel and choose “Move”.

23. Enter coordinates of 15.5” for the
“X”and .5” for the “Y™.

Image Layer Map

-

Mapped Layers

Unmapped Image Layers

iowes 35003 [Inner] -

Layer Name

| Type

& 7 <empty> [Plane Neg]
L 25002 [Plane Neg]

& 3 <empty> [Plane MNeg]
‘ol 55005 [Plane Neg]

w9 <empty > [Inner]
Lwen 4 5004 [Inner]

e 10 <empty> [Bottom]

) 11 <empty> [Border]
.03 7 Outline [Border]
12 <empty > [Mask Bot]
\.4F% 10 BottomMask [Mask B -
4 m 13

Copy Mapped Layer

Names... |

Cancel

To map an image layer, drag the layer from the Unmapped Image Layers or from
another panel layer and drop it on the panel layer to which it is to be mapped.

Advanced Panelization

Panel ]Image Layout | Robber Bars Venﬁng&Thievwng}

Image Files b ¢

C:\Users\stan Desktop [PC-Demo.gtd
C:\Users\stan Desktop\6i2p_250_pin_a.gtd

¥ Imags Layout
2 Minimum Spacing
0 Bxact Spacing
3 Mumber of copies
@ Manual placemert

Number of copies 1
¥ Imags Fotation 0
E} Panel edge to image spacing
3 Symmetrical
@ Margin
Top 0.600
Bottom 0.600

Left 0.400
Right 0.400
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Cancel

Move...
Rotate...
Mirrored
Delete
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o]

Cancel |
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24. Select the “612p_250 pin_a.gtd” file in the “Image Files” box.

25. With this file highlighted, select “Manual Placement”, and change
the “Number of copies” to 6.

26. Use the right mouse button to click on one of the green images in
the preview panel and choose “Move”.

27. Enter coordinates of 9.0” for the “X” and .5” for the “Y”.

28. Use the right mouse button to click on a different one of the green
images in the preview panel and choose “Move”.

29. Enter coordinates of 9.0” for the “X” and 23.5” for the “Y™.

30. Continue selecting and moving each " 220020t (030 x0.500)

Panel Size:  18.000 x 24.000

unmoved green image and enter the
following coordinates respectively for

each move:

e .5” for the “X” and 8.0” for
the “Y”.

e .57 for the “X” and 16.0” for
the “Y”.

e 23.5” for the “X” and 8.0” for
the “Y”.

e 23.5” for the “X” and 16.0”
for the “Y?”.

31. Select the “IPC-Demo.gtd” file in the
“Image Files” box.

32. With this file highlighted, select
“Exact Spacing”.

33. Change the spacing in the “X” and “Y” to .2”.

34. Place a check mark in the box labeled “Center images within

margins”.
35. Choose “90” for the “Image Rotation”.
Advanced Poncization o 36. In “Panel edge to image spacing”,

Ford |moge Lot |nabromrs | Vrwgathews | e select margin and enter the following values:
p— K] | parcisae: 00020000 e Top:15”

G e S e Bottom: 1.5”

E}gag;‘m;nspamg L] Left 75"

B e Right: .75"

SR 37. Select the “Robber bars” tab.
gf%“N“Rh'T i} 38. Click the “Define Layer Sets” button.
S ™ 39. On the “Panel Layer Set Setup” dialog,

& 15 click “New Layer Set”.

= i 40. Name the layer set “Outer” and click

Right 0750 “OK”.

41. Drag and drop the Top and Bottom

layers onto the “Outer” Layer set.
— 42. Click “New Layer Set” again.

43. Name the layer set “Inner” and click “OK”.
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44,
“Outer” Layer set.
45. Click “New Layer Set” again.
46.
“OK”.
47,
“Plane” Layer set.
48.
Setup” dialog.
49,
Bars” Tab of the “Advanced
Panelization” Dialog.
Select the “Outer” layer set.

Place a check mark in the “Add
Robber Bar” box.

Enter a value of 1” for “Width of
Robber Bar” and “Clearance
from Panel Edge”.

Remove the check marks from
the left and right sides in the
“Generate Robber Bars on these
edges” area.

Select the “Venting & Thieving”
Tab.

Select the “Inner” Layer Set.

50.
51.

52.

53.

54,

55.
56.
57,
58.

Unselect the box for “Line 3”.

.05
.25
135

o Size:
e Spacing:
e Angle:
59.
e Size: .05
e Spacing: .25
e Angle: 45
60. Change “Polarity” to negative.
61.
values:

e From panel edge:

e From panel & image data:

62.
63.
64.

Select the “Plane” Layer Set.

Unselect the box for “Line 3”

Drag and drop the Inner layers onto the

Name the layer set “Plane” and click
Drag and drop the Plane layers onto the
Click “OK” on the “Panel Layer Set

You should now be on the “Robber

Panel Layer Set Setup - [éj
Layer Set List: Layer List:
'_rg Outer Layer Name | Type | -
odak 5 <emptys CE 1 <empty> NC
e 10 <empty [ 2 <empty> SikTop  |E
12 Inner Wil 3 <empty> Paste ...
[ & <empty> 34 <empty> Mask Top
oees 9 <Empty > 4545 cempty Ton
MNew Panel Layer Set Name |i|éj

Flane

Cancel

drag layers back to the layer list.

e Cayer St 1

Delete Layer Set | OK

To add layers to a Layer Set, drag layers from the layer list and drop on to the
desired layer set name in the Layer Set list. To remove layers from & layer set,

Choose the “Hatch” radio button.

Change the value for “Line 1” to:

Advanced Panelization

Panel | Image | Layout Rabber Bars | venting & Thieving |
Layer Set: [quter <] Define Layer Sets...
¥ Add Robber Bar

Width of robber bar:

1,000
Clearance from panel edge: | 1.000

Generate Robber Bars on these edges:

v

Image File: IPC-Demo.gtd (5,925 x 3.954)
Panel Size: 18,000 x 24.000

Change the value for “Line 2” to:

In the “Clearances” section, set the

Choose the “Hatch” radio button.

DS

Advanced Panelization
Panel I Image] Layuutl Robber Bars Venting & Thieving I
Layer Set: |Inner ~| Define Layer Sets...
> Dot
@ Hatch
Line 1
Size 0.050
Spacing Betwsen Centers 0.250
Angle 135
Line 2
Size 0.050
Spacing Betwsen Centers 0.250
Angle 45
[J Line3
Polarty Nagative
0 Star Burst
2 Solid
7 None
0 R O Save Pattern... | Load Pattern... |
0 1 Clearances
From panel edge: 0.000
From panel &image data: | 0.100

Image Fie: [PC-Demo.gtd (5.525 x 3.959)

Panel Size:  18.000 x 24.000 Pattern Preview [
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Image File: IPC-Demo.gtd (5,925 x 3.954)

Layer Set: |Plane x| Define Layer Sets... Panel Size:  18.000 x 24.000

From panel edge:

From panel & image data:

2 Dot
‘@ Hatch
Line 1
Size 0.050
Spacing Between Centers 0.250
Angle 135
Line 2
Size 0.050
Spacing Between Centers 0.250
Angle 45
[ Lne3
Polarity Positive
> Star Burst
> Solid
> None
Save Pattern... | Load Pattern... |
Clearances

0.000
0,100

Advanced Panclizatio ol

Panel | mage | Layaut | Robber Bars Venting &Thieving |
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65. Change the value for “Line 1” to:
o Size: .05
e Spacing: .25
e Angle: 135
66. Change the value for “Line 2” to:
e Size: .05
e Spacing: .25
e Angle: 45
67. In the “Clearances” section, set the values:
e From panel edge: 0.0
e From panel & image data: 0.1
68. Click “OK” to complete the Advanced
Panel setup.
69. Click “OK” when prompted to map
unmapped Tools.
70. Your Panel is now complete.
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Creating a Panel Template

Many manufacturers have standard panel attributes that are used for
several jobs. You can create pre-defined panel "templates" for use on
multiple jobs, to streamline the panel creation process. There are
several pre-defined panel templates and elements provided in the
GerbTool program directory, in the Samples/Template folder.

1.

2.

o

Define a panel as described above, with whatever attributes
you wish (size, venting, panel elements, layer setup, etc.).

If you have a standard tool table, use the Setup | NC Tools to
define your shop's tooling. If you do not define a tool table in
your template, the first image that you load into your template
upon panelization will determine the tool table definitions.
Save the template as a .gtd file.

To use the template in the future, use the Advanced
Panelization function and load the saved panel template image
first.

Add whatever images you want to step & repeat, and define
their placement, layer mapping, etc. in relationship to your
panel template.

When you define the layer mapping, if any NC data exists in
the images, you are also required to map tool definitions to
your template's tool table. Again, if you did not define a tool
table in your template, the first image you load into the
template will define the tool table. If you load additional
images into the table, you must then map their tools based
upon the definitions from the first image.

When you have completed your panel, save it as a new .gtd file
or export it as necessary. By saving your completed panel as a
new file, your template file remains untouched, and you have a
new panel ready for manufacturing.

Review questions

1. What types of files are needed in order to perform Advanced
Panelization?

2. What is the best way to include title blocks, pinning holes and
coupons in the panel?
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3. How can a panel template be created and used?
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Contact Information

WISE Software Solutions, Inc.

2700 E. 9th St,

Suite 100

Newberg, OR 97132

USA

Tel: 1 (503) 554-8855

Fax: 1 (503) 554-1220
Support: 1 (503) 554-8855
Web: http://www.wssi.com
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